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1 Introduction

In the following we assume that:
* you are familiar with your Windows® operating system,
¢ you know how to use Windows® online help files.

1.1 Typographical conventions

To facilitate clear identification and for easier reading we use the following
conventions in this quick guide:

1. Stands for Attention.

& This symbol indicates an important detail or a special feature.

\@; Paragraphs with this symbol provide a tip or explain an interesting
feature.

i) This symbol is located in front of links to further information.

Individual terms within the text are highlighted in italics. Other special nota-
tions include the entries you need to make, all buttons, checkboxes, the
names of input fields, etc. The menus, commands, dialog boxes and
windows used in the program, as well as tabs and groups on the ribbon,
are also identified.

(XY 4 This symbol indicates further information which you will find in the
online help.

~@: Use %t (in the menu bar of this Help) to enlarge or reduce the font
size in this Help. Each click on the symbol switches to the next of
five (preset) font sizes.

catman® A01235_15_Y00_00 HBM: public 3
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1.2 Usage

If you are not familiar with catman, we recommend that you read the section
Quick start once the installation is completed.

2 For all other queries call the context-sensitive catman online help. In
many dialogs you will find a link to the corresponding topic in the
help directly adjacent to the entry fields: (2.

If there is a problem which you cannot overcome, in the Technical support
section you will find further ways of obtaining help directly from HBM.
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2 System requirements

To operate the current version of catman, your PC should meet the following

requirements:

* Intel Pentium or equivalent processor upwards from 1 GHz

« Windows® 7 (32-bit or 64-bit version, Home, Professional or Ultimate
editions), Windows® 8.1 (32-bit or 64-bit version) or Windows® 10 (lat-
est 32-bit or 64-bit version)

& The file system should be NTFS.

* Microsoft Internet Explorer Version 8.0 or higher

* Atleast 2048 MBytes of main memory (RAM)

« Graphics card or screen with a resolution of at least 1024 x 768 pixels.
We recommend a resolution of 1600 x 900 pixels or higher. With small
screens with higher resolution use the Windows Control Panel (Display
settings) if necessary to enlarge the display of text and other screen ele-
ments.

* Approx. 1 GB of free storage capacity for the program installation; at
least an additional 1 GB is needed for temporary storage of data; how-
ever you can also use a different drive for this (not a network drive)

*  Microsoft or 100% compatible mouse

« Configured standard printer

* One of the following interfaces is required to connect measuring
devices":

« USB, Ethernet (10/100 MBit), FireWire (IEEE 1394b2) or RS-232
(COM1, COM2).

» The following fonts must be installed:

* Arial (TT), Courier, MS Sans Serif, Small Fonts, Tahoma, Times New
Roman (TT), Verdana, Segoe Ul and Wingdings. Usually these fonts
are installed with the Windows operating system.

No interfaces are needed for catman PostProcess.

2)  With FireWire only interfaces to IEEE 1394b are supported. The HBM driv-
ers for the interface (including adapters for IP over FireWire) must be
installed (included in the catman installation software).

®
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Notes

» To be able to save measured data, sufficient free space should be avail-
able on your hard disk. To make a rough estimate of the space required:
approx. 8 bytes are required for each measured value, i.e. for 100,000
values approx. 40 megabytes are necessary for 50 channels. The disk
drive, on which the temporary file for the temporary data storage is cre-
ated, can be changed using the menu File -> Options and Data storage
(System group).

» If there are numerous channels we recommend a Fixed storage size
for the temporary data storage. This will improve the speed of the (tem-
porary) data recording.

See also Data storage (System group).

* If no more free space is available on the specified hard disk, the mea-
surement is aborted. However you can see, for example next to @ in
the status line, how long you can continue measuring before this hap-
pens (d = days, h = hours). The computation uses 100 megabytes as
safety reserve. The background of the status display will change to red
as soon as there is less than 1 gigabyte of free space.

* The above requirements are sufficient if you use low sample rates, few
channels and carry out only a few graphical tasks. You must use a more
powerful PC if you wish to use a lot of measuring or calculation chan-
nels or carry out complex graphical tasks using high sample rates.

2.1 Data storage options

Temporary data storage
(i) See also System requirements, catman work folder.

To be able to retain the measurement data until you have decided on the
next processing steps (at the end of the acquisition), catman uses a tempo-
rary storage. In the default setting, a special file is produced for this in the
catman working directory. If the path for this user folder is a network path,
on starting catman you receive the notice that this is not admissible. Then
specify a local path (a folder on your PC's hard disk) in the following dialog
and catman then creates all the required files in this path.

6 A01235_15_Y00_00 HBM: public catman®
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With several PC users with different Windows accounts (user
names), we recommend using one file for all users so that a large
amount of space is not reserved for these files unnecessarily. How-
ever, be sure to select a folder to which all users have read and write
access. Specify this folder for all users of catman.

When using an operating system with the NTFS file system, this file can
grow dynamically as long as there is free storage space available on the
hard disk. Therefore all data can be acquired and exported after the mea-
surement into a “normal’” file. The status message “Setting up temporary
data storage” displayed during the start of catman signifies that this special
file is being initialized.

If the file system used on your hard disk is not NTFS, select Use
fixed storage size and specify the size to be used for the temporary
storage. The maximum number of values per channel that you can
acquire with your configuration (number of channels and storage
space) will be displayed.

As a reference value for estimating the size of the temporary file, use 8
bytes per measured value, i.e. with 1,000,000 values (about 7 minutes at
2,400 Hz sample rate) approx. 400 megabytes are needed for 50 channels.

If no more free space is available on the specified hard disk, the
measurement is aborted. However you can see, for example next to

@ in the status line, how long you can continue measuring before
this happens (d = days, h = hours). During the computation 100 MB
of safety reserve is included. The status indicator is highlighted in
red when the free space falls below 1 GB.

How do you find out which file system is used on your hard disk?

Call the Properties context menu in the main folder of the hard disk (e.g.
c:\). The third entry in the following dialog shows the file system used.

& If the hard disk of your PC was not already formatted with NTFS at
the factory, we recommend that you do this afterwards. Usually the

®

catman A01235_15_Y00_00 HBM: public 7



I
[
<

PC supplier provides a conversion program for this purpose. Other-
wise, try CONVERT.EXE (in the SYSTEMS32 subdirectory of Win-
dows) with the parameters c: /fs:ntfs, if c: is the drive that
needs to be converted (CONVERT.EXE c: /fs:ntfs).

The conversion takes place without any loss of data, but for security
reasons you should make a backup of your hard disk first.

2.2 catman working directory

§.  The catman working directory must not be created on a network
drive.

After the installation of catman all other files and folders required by catman,
for example for the sensor database, saving data or projects and the tempo-
rary data storage are created in the catman working directory. You can mod-
ify some of these folders or paths with the appropriate options. However, the
catman working directory is also needed, for example, for the temporary
storage of data during computations and it contains the AutoSequence
examples. In the default setting the catman working directory is generated
in the folder “My Documents\HBM” of the user logged in under Windows. If
this is a network path, when starting catman you then receive the message
that this is not admissible. With this option you can specifically select a
folder for saving the data required by catman.

l}

Specify a folder which is shared by all users, if several users log in
under Windows with different names and should use the same set-
tings. Otherwise, it is sufficient if you define the same sensor data-
base (see On-line help, Options for sensors in the Program options)
and possibly the same path for the temporary data storage for all
users.

N/,
D
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3 Installation/Upgrade

(i) See also Licensing and registration

& The installation requires Administrator rights. We recommend that
you close all open programs. After installation it may be necessary
to restart Windows.

Insert the DVD into your drive. In the standard configuration Windows auto-
matically opens the DVD and the start window appears.

If you have deactivated the self-starting Windows function or downloaded
the installation files, look for the file “Start” or “Start.exe” (main folder of the
DVD or download) and double-click on its icon to obtain the start window.

At the top right of the start window select the installation language at Lan-

guage.

Click on Install catman and follow the instructions of the setup program.

Read the licensing agreements and specify the folder in which the software

is to be installed: either confirm the suggested target folder or click on

Browse and choose the one you want. The setup program creates—where

necessary—the folder you have specified and then copies all files to it. In the

next step you can select the optionally installed components:

* Install HBM-USB driver: The driver is only needed if you want to oper-
ate the HBM device MGCplus with CP22/42 using a USB interface in
your PC. Initially, only the required files are copied; the driver is only
fully installed (automatically) by the operating system on connecting a
device.

See also Notes on the USB interface.

» FireWire driver: The drivers are only needed if you want to operate
QuantumX/SomatXR modules via a FireWire interface in your PC. The
driver is not needed for connecting a CX27 or MX module with C func-
tionality (e.g. MX471C) via Ethernet to the PC and via FireWire to other
QuantumX/SomatXR modules.

See also Notes on the FireWire interface (IEEE 1394)

*« CANHEADdirect driver: The driver is only required if you want to oper-
ate CANHEAD® modules via the USB-to-CAN adapter (Peak).
See also Notes on the CAN bus interface (CANHEADdirect)

catman® A01235_15_Y00_00 HBM: public 9
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NPT time server: The installation is only practicable with Quan-
tumX/SomatXR, MGCplus, PMX, DMP41 and FS22 BraggMETERS,
because they can be supplied via the time server with exact time speci-
fications. The time server from Meinberg is installed. Synchronization of
the time server with a time server in the Internet is not required and is
also not set up by the automatic installation. The time server is only
used for synchronizing the devices taking part in the measurement.
You can also install the NTP time server later or on a different PC; see
also http://www.meinberg.de and “Synchronizing multiple devices” in the
online help.

Install legacy TEDS editor: Installation is normally not necessary, as
you can use the Sensor database to write to new (empty) TEDS mod-
ules or simply modify existing ones; see “Using transducers with TEDS”
in the online help. The editor is only needed when you want to view or
edit TEDS content as specified in the TEDS standard.

Before actually copying the files into the folder, the installation program will
display a summary of the operations to be executed. Confirm these with
Install.

Notes

10

We recommend starting catman once directly after installation with
administrator rights. Enter the license number and connect the devices
to be operated so that the drivers are fully installed (requires administra-
tor rights).

The retrospective installation of a driver can take many minutes,
because Windows first attempts to find the driver via the Internet. We
therefore recommend that the installation is carried out using the pro-
gram appropriate to the driver (see the following “Notes ... ” sections for
the relevant interface).

A01235_15_Y00_00 HBM: public catman®
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3.1 Notes on the Ethernet interface

Windows Firewall

If you establish a connection to an HBM device via the Ethernet interface, it
is usually blocked by the Windows firewall or by the firewall of your anti-
virus program. An exception is defined for the Windows firewall during the
installation of catman. For other programs enable access for catmanEasy
or catmanEasy-AP.

Other Firewalls

Depending on the devices connected, open the following ports:

¢ QuantumX/SomatXR: TCP ports 80, 5001 and 7411, UDP for ports
1200, 1201, UDP-Multicast for ports 1300, 1301, 31416 and 31417, for
the CX27 the TCP ports as from 50 000,

*  MGCplus with CP22/42: TCP port 7 (no UDP or multicast present),
MGCplus with CP52: TCP ports 7 and 80, UDP-Multicast for ports 31
416 and 31417,

*  DMP41: TCP port 1234, UDP-Multicast for ports 31416 and 31417,

*  PMX: TCP port 55 000, UDP-Multicast for ports 31416 and 31417,

+ FS22 BraggMETER: TCP ports 3500 and 3365,

+ Kistler System 2000: UDP for ports 8888 and 8889,

+ Kistler KiRoad: TCP ports 6155 and 6158, UDP for port 6156.

Connecting to MGCplus via WLAN (WiFi)

If you are not connecting the MGCplus through cable but instead through a
WLAN, with slow networks interruption in the connection (timeout) may
occur. In these cases set the waiting period for the interrogation of the out-
put buffer to a higher value.

Changes to the Registry using the regedit.exe program should only
be made by experienced users, and after backing up the existing
Registry, because under some circumstances serious Windows
errors might result. If necessary, ask your administrator to make the
change.

-

catman® A01235_15_Y00_00 HBM: public 11
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Under HKEY_LOCAL_MACHINE/SOFTWARE/HBM/CATMAN/SETTINGS
create the new string MGCGetFifoTimeout and enter a value of above 500
(ms), e.g. 1500.

3.2 Notes on the USB interface

You can also install the USB driver during installation of catman (default set-
ting: USB driver is installed). If this has not occurred, you can also install the
driver retrospectively; see the following description.

About the driver version

The driver for MGCplus supplied with catman was revised in 2010 and is
now available in the version 3.3.3.2 of 25.3.2010: It is signed (necessary for
the 64 Bit versions of Windows) and no longer requires a setup program if a
device is to be connected to another USB port on your PC. If on connecting
a device a Windows dialog appears with the message that new hardware
has been detected, use Install software automatically so that Windows
will then find the driver automatically. Depending on your system, a com-
plete installation may only have to be carried out if connecting a (new) USB
hub. In this case proceed as described below for the installation.

Driver update, checking the driver version

If you already had an older installation of catman on your PC, an old driver
may have been retained with a new installation. To install a new driver the
old driver must first be uninstalled. Normally, this is carried out by the instal-
lation program. If this does not occur, e.g. because the installation has been
interrupted, you have to perform this manually (administrator rights
required). You can also view the currently installed versions of newer drivers
by choosing Control Panel -> Programs and Functions or in Windows 10
Settings -> System -> Apps & Features. Otherwise use the procedure up
to Step 4 described below.

Procedure to uninstall an old driver
1. Connect an MGCplus via USB.
2. Call up the Windows Control Panel.

12 A01235_15_Y00_00 HBM: public catman®
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Double click on “Device Manager”. (If necessary change the display.)

Old drivers are shown as a subentry for the “USB controller’, new ones
have a dedicated entry. Right click on the entry and select Properties.

The currently installed version is shown in this dialog.

On the Driver tab click on Uninstall driver and wait until this task is fin-
ished.

Unplug the USB connector from the MGCplus.
Wait for approx. 10 seconds before you install the new driver.

Procedure for the (retrospective) installation of a USB driver

1.
2.
3.

Go to the “DriverSetups” folder in the installation folder of catman.
Doubile click on “HBM USB IO Driver Setup.exe”.

Read through the license agreements and follow the instructions of the
setup program.

The setup program copies the required files into the appropriate Win-
dows subfolder and sets up the driver.

Plug the USB connector into the MGCplus.

If a prompt appears asking whether you want to connect to Windows
Update, choose No, not this time and click on Continue.

Activate Install software automatically.

Windows then updates the required files. Please wait until the message
“New hardware found” appears in the Windows taskbar. Only then start
catman.

The new driver is displayed as a dedicated entry under “HBM USB Devices”
in the Device Manager as soon as a device is connected. The drivers are
also displayed in the list of installed programs (Control Panel -> Programs
and Functions or in Windows 10 Settings -> System -> Apps & Fea-
tures).

catman® A01235_15_Y00_00 HBM: public 13
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3.3 Notes on the FireWire interface (IEEE 1394)

The required FireWire drivers can also be installed during the installation of
catman (optional components). If it has not already been done, you can also
install the drivers retrospectively; see the following description.

& The installation requires administrator rights under Windows. If you
are using a plug-in card for the FireWire interface, you should insert
the card into the PC before the installation. Then the HBM driver for
the card is automatically activated.

For the FireWire interface (IEEE 1394b) of the QuantumX/SomatXR mod-
ules you have to install the driver supplied by HBM. You can however switch
back at any time to the original driver of your interface.

After the installation, start catman as usual and in the Prepare new DAQ
project dialog specify FireWire as the interface.

IP over FireWire (HBM IEEE1394 IP Adapter)

From Version 3.4 the communication with the QuantumX/SomatXR mod-
ules also takes place by FireWire similar to Ethernet. In this respect a virtual
interface for each physically existing FireWire interface is set up: IP over
FireWire. A maximum of two adapters are created and are visible in the net-
work connections. As IP addresses 24.0.0.1 and 25.0.0.1 are used; conse-
quently the IP over FireWire interface adapters are named IP over FireWire
24 and IP over FireWire 25. (The latter is only present if more than one
physical interface is installed in the PC1). Only the Internet protocol TCP/IP
(IPv4) is required for the IP-over-FireWire interface; the client for Microsoft
Networks or the QoS Packet Scheduler is not required.

Procedure for the (retrospective) installation of the drivers
1. Go to the “DriverSetups” folder in the installation folder of catman.
2. Double click on HBM IEEE1394 Driver Setup.exe.

) AFireWire card can have, for example, three connections, but despite this it
is usually registered in the system as only one interface. In this case only
one IP-over-FireWire adapter is set up (HBM IEEE 1394 |P Adapter).

14 A01235_15_Y00_00 HBM: public catman®
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3. Read through the license agreements and follow the instructions of the
setup program.
The setup program copies the required files into the appropriate Win-
dows subfolder and sets up the drivers and the IP-over-FireWire
adapter.

: /; If you have connection problems, check whether the interface
adapter IP-over-FireWire 24 has been correctly set up (Windows
Control Panel -> Network and Sharing Center -> Change adapter
settings). If not, connect a device and double click on ‘HBM
IEEE1394 IP Adapter Wizard.exe” in the “DriverSetups” folder.

\

Activating the HBM driver with several interfaces
(i) The HBM driver is a modified Thesycon driver.

If your PC has more than one FireWire interface, you must define for which
interface the driver is to be used.

1. Start the program “t1394bus_installwizard.exe” (Thesycon T1394bus
Setup Wizard) in the folder “HBM IEEE1394 driver”. The folder is cre-
ated within the “HBM” folder in the “Programs” folder of Windows.

2. Select the required IEEE 1394 host controller by clicking in the list. The
“Thesycon T1394bus Setup Wizard” shows all 1394_OHCI_HostCon-
trollers located in the PC. If you have several adapters, you can select
one of them. Otherwise click the first entry.

3. Click on Switch to T1394bus driver to install the HBM driver.

4. Close the program “Thesycon T1394bus Setup Wizard”. The driver is
now installed and ready for use.

If you want to again activate the original driver of your FireWire interface,
restart the “Thesycon T1394bus Setup Wizard”, select the relevant IEEE
1394 host controller and click on Switch to in-box T1394 driver. This deac-
tivates the HBM driver, but does not uninstall it. You can switch between
both drivers at any time.

Remove T1394bus driver from system removes the HBM driver com-
pletely from your PC.

®
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Installing the device-specific driver
1. Connect the MX module.

After a short time a Windows dialog opens with the message that new
hardware has been detected and it asks whether to look for a driver on
the Internet.
Activate No, not this time and click on Continue.
3. Activate Install software automatically.

Windows then updates the required files. Please wait until the message

“New hardware found” appears in the Windows taskbar. Only then start
catman.

n

3.4 Notes on the CAN bus interface for
CANHEADdirect

The required CANHEADdirect drivers can also be installed during the instal-
lation of catman (optional component). If it has not already been done, you
can also install the drivers retrospectively; see the following description.

To obtain the CAN bus interface on the PC for the direct connection of CAN-
HEAD® modules, you must install the USB-to-CAN adapter from Peak and,
if necessary, configure a CAN network. After the installation, start catman as
usual and in the Prepare new DAQ project dialog specify CANHEADdirect
as the interface.

Procedure for the (retrospective) installation of the driver
1. Go to the “DriverSetups” folder in the installation folder of catman.
2. Double click on “HBM Peak Driver Setup.exe”.

3. Read through the license agreements and follow the instructions of the
setup program.

The setup program copies the required files into the appropriate Win-
dows subfolder and sets up the driver.

16 A01235_15_Y00_00 HBM: public catman®
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Configure USB-to-CAN adapter
1. Insert the USB-to-CAN adapter into a free USB interface on your PC.

2. Switch on the adapter power supply (the two LEDs on the connection
side should light up green).

After a short time a Windows dialog opens with the message that new
hardware has been detected and it asks whether a driver is to be sought
in the Internet.

3. Activate No, not this time and click on Continue.

4. In the next window enable Installation of software from a list or cer-
tain source.

5. Specify the path to the file PCAN_USB.SYS (CANHEADdirect folder in
the catman installation folder). Windows then copies the required files
into the appropriate Windows subfolders.

Configure CAN network

For various applications the software from PEAK facilitates the definition of
several CAN networks, which, for example, use different bit rates, even
when only one adapter is available. Depending on which network you later
select, the appropriate bit rate is then used without you having to change
the bit rate on the adapter itself each time. In addition, the PEAK software
includes programs for indicating the status and for testing CAN bus devices
via CAN messages.

During the installation of catman a network for the CANHEAD® modules is
already set up if the adapter was connected during the installation. If not,
connect the adapter and start the program NetCreator.bat in the folder
CANHEADdirect (in the catman installation folder) in order to automatically
set up the CANHEAD_DIRECT network. The 250 kBit/s bit rate to be used
is also set here.

catman® A01235_15_Y00_00 HBM: public 17
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4 Uninstalling

To uninstall catman open the list of installed Windows applications. Then
select the catman installation.

Opening the list of apps under Windows 10

In the taskbar search box type Change or remove a program and open
the suggested Control Panel program.

Alternatively, you can use Settings -> System -> Apps & Features on the
Start menu or All settings -> System -> Apps & Features in the Info Cen-
ter.

Opening the list of apps under Windows 8/8.1

From the Charms menu on the Windows desktop (not in tile view) open
Settings -> Control Panel. Double click on Programs and Features (View
by: Small icons) or Uninstall program (View by: Category).

Opening the list of programs under Windows 7

From the Windows Start menu choose Control Panel -> Network and
Sharing Center. Double click on Programs and Functions (View by:
Small icons) or Uninstall program (View by: Category).

Notes

*  Only the files which were created during the installation are deleted. The
files created when using catman are not removed.

» Together with catman, installed utility programs, such as the NTP time
server, are not automatically uninstalled. If you no longer need the appli-
cations, use the Control Panel in Windows to uninstall them.

» Also programs and drivers which were installed for special interfaces
like USB, CAN bus or FireWire will not be automatically uninstalled. Use
the Windows Control Panel to uninstall these drivers.

18 A01235_15_Y00_00 HBM: public catman®
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5 Licensing and registration

& See also https://www.hbm.com/terms/software for the license terms
for software (EULA)

The first time you start the program, you must enter your name and com-
pany and the license number shown on the DVD. If you do not enter a
license number, catman will start in Evaluation mode (a maximum of 25
starts with all functions is possible).

Click on Info in the catman start window if you want to:

» Enter your license number at a later point in time.

« Change the name or company.

*  Produce a file with information about your PC system (system info file)
for HBM Support.

+ See all activated modules, e.g. EasyMath (mathematical functions and
AutoSequences).
* View the release notes for the current version.
See also “What is new in catman? (History)” section in the online help.
The current license data are shown in the window on the right-hand side.
Click on Modify to modify settings.

Notes on the Map panel object (only available with catman AP, catman
PostProcess or EasyRoadload additional module)

The object loads a map view from the Internet which is made available by
Google Ireland Ltd. When querying, no user information or PC parameters
are passed to Google apart from the querying IP address.

The maps can only be used in conjunction with catman. Owing to licensing
law restrictions, the object is unavailable in some countries, including China
and North Korea. You can, however, switch to using Baidu maps if you have
a Baidu account. For details refer to the Knowledge Base under “Working
with Baidu Maps in China” and
http://Ibsyun.baidu.com/index.php?title=webapi.

catman® A01235_15_Y00_00 HBM: public 19
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Registration and activation of software maintenance

Please register at systems@hbm.com with an email to activate your service
contract. HBM needs your registration to be able to ensure that you can be
informed when a new version appears and that you receive the license
number necessary for this. After completing registration you will also
receive the appropriate telephone numbers from HBM via email for direct
access to the catman support in your region. The following information is
required:
1. The program designation (catman Easy, catman AP or catman PostPro-
cess).

2. Your current license number.

3. Your company's name.

4. Your name and, where applicable, department.

5. Your email address.

& Reregistration for another name and/or another email address is

possible at any time.

Module activation

1. Click on Options in the catman start window.

2. Activate your module via Program functions (System group).
3. Enter your module license number in the following dialog.

& The license number is only required the first time you activate the
module. You may disable the module via the menu File -> Options
and Program functions (System group) at a later point in time, if it
is not required. To activate it again, just click in the appropriate box.

All activated modules and your main license number are displayed in the
program if you click on Info in the start window or on About catman in the
Help menu.
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6 Quick start

catman® is the measurement software for the HBM devices QuantumX,
SomatXR, MGCplus, CANHEAD®, PMX, DMP41, eDAQ (SoMat) and the
FS22 BraggMETER SI/DI for measurement with optical strain gages. It
enables you to perform different measuring tasks quickly and simply without
having to undertake any time-consuming programming. Apart from the HBM
devices, you can also connect a GPS system, the Vaisala Weather Trans-
mitter WXT520, a GOM Testing Controller (ARAMIS) for optical strain mea-
surement or Kistler RoaDyn sensors (System 2000 or KiRoad) to catman.

catman recognizes not only the configuration of the HBM measuring
devices connected, but thanks to the optimum interaction of hard- and soft-
ware also the entire measuring chain is automatically configured if you are
using, for example, TEDS transducers. For DAQ channels with conven-
tional transducers, use the integrated catman Sensor database and simply
assign the transducers you are using to the individual channels. The Sensor
database already contains all HBM transducers as templates, and typical
sensors such as thermocouples, Pt100, voltage or current sources, but can
also be easily extended to include your own transducer types. CAN signals
can also be included in the Sensor database and assigned to CAN recep-
tion channels. You can also write the sensor data from the Sensor database
into a TEDS module or transfer the data from a TEDS module to the Sensor
database.

Use the default settings of catman or define your own measurement
sequences, called DAQ jobs: define sample rate, start and/or stop trigger
including pre-trigger time and time until stop (post trigger), select time points
for start and stop or start and stop the measurement manually. The settings
can also be mixed, e.g. start with trigger and stop after a certain time or
number of measurements etc. Produce your own visualization with the
graphical objects of catman. Graphs which show you the measurement
curves during the measurement, Digital or Bar indicators and various other
objects are available. You can however also use the default settings of cat-
man and immediately start with the measurement. Even during the mea-
surement you may assign further channels to graphs or create new graphi-
cal objects.

catman® A01235_15_Y00_00 HBM: public 21



HBM

You can extend the basic version of catman Easy with additional modules
(available for purchase). The catman AP version includes catman Easy and
the most frequently used modules.

The version catman PostProcess is restricted to the Analysis mode (con-
nection of devices and acquisition of data are not possible).

L)

6.1

Please register with HBM to activate your service contract. HBM
needs your registration to be able to ensure that you can be
informed when a new version appears and that you receive the
license number necessary for this, see Licensing and registration.

Prepare a new DAQ project: Device scan

Access the settings for the device search in the menu Measure in

the start window of catman via Select device type, interface and

additional hardware options or via the menu Options in the start
window of catman and Prepare a new DAQ project.

On starting a new DAQ project the interfaces activated in the device search
are searched for those devices activated under Search device types. The
devices must be switched on and ready for operation, otherwise they will
not be found. Therefore, after switching on the devices wait long enough
before you start a new project or load an existing one.

N,
D

22

Simultaneous connection of different HBM devices is supported by
catman but with restrictions: with eDAQ/eDAQ-lite, DMP41, PMX
and CANHEADdirect, only additional devices of the same type can
be used. QuantumX/SomatXR or MGCplus can also be used
together with FS22 BraggMETERSs or a GOM Testing Controller
(ARAMIS). Irrespective of this you can include, for example, a GPS
receiver via Options and the Additional devices tab or the HBM
Device Manager in the DAQ project.

Only search through the interfaces which have devices connected.
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6.2 Using the HBM Device Manager

QuantumX/SomatXR modules with firmware 4.0 or higher, PMX and
MGCplus with CP52 broadcast their IP address cyclically in the network.
These messages are collected and evaluated. Therefore the IP address set
on the device is unimportant as all devices are found which are in the
(Ethernet) network (or, with MX modules, can be reached through FireWire).

If you have old MX modules, you must first update the firmware.

Procedure

¢ Click on New module scan if the device or module is not shown on the
Found modules tab.

All devices or modules are listed on the Modules found tab, even mod-
ules or devices to which no connection is possible.

+  For an identification with 8 change the IP address.
) is shown before the module address if the device or module can be
set up and measurements can be supplied. As a rule, the PC and the
device must be in the same network segment for this purpose.

*  On the QuantumX/SomatXR or MGCplus with CP52, if the text
“...update needed” is displayed in the Firmware column, you must
update the relevant module or device.

\@; If you have already selected and used devices or modules before in

the Device Manager, you can activate Connect to devices last in
use in the start window (Measure menu) to connect directly to these
devices (without displaying the Device Manager again).

Several MX modules are sorted according to their names and are accepted
into the channel list in increasing alphabetical order. In order to transfer
PMX devices into the channel list in alphabetical order it is sufficient if you
sort the list in the HBM Device Manager: Click on the Name column before
connection. QuantumX/SomatXR modules connected via a gateway, such
as a CX27 module or modules with C functionality, such as an MX471C, are
displayed in a tree structure below the gateway.

®
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Using MX471C as a gateway

Click on New DAQ project as necessary to call the HBM Device Manager.
On the Change module settings tab you can enable the gateway function-
ality. The function is disabled by default.
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7 Technical support

& Please always have your license number ready. You will find this on
your catman DVD or in the catman info window (About catman
menu item in the Help menu).

If you encounter any problems when working with catman, you can use the
following services from HBM:

E-mail support
info@hbm.com

Telephone support
Telephone support is available on all working days from 09:00 to 5:00 PM
(CET):

+49 6151 803-0

Fax support
+49 6151 803-9100

|

NS
A

We recommend that you complete the registration dialog (see
Licensing and registration) and send the data to HBM. Then you will
receive separate telephone numbers for direct catman support from
HBM. In addition—provided your maintenance and service contract is
valid—you will be informed when a new version is available and will
also receive your new license number.

System info file

To enable you to give HBM support information about your PC system, pro-
duce a system info file using the dialog with the license details (Info in the
start window or About catman menu item in the Help menu). Before pro-
ducing the file CATMAN_SYSINFO.TXT, you can select the file path and the
path is also displayed again after it is produced.

®
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You also have the following possibilities available:

HBM Support and Sales International
https://www.hbm.com/contact/worldwide/

Download software updates from HBM

https://www.hbm.com/Software

Please note that the new software versions (e.g. 5.0, 5.1, etc.) also require
a new license number. Therefore make sure you register (see Licensing
and registration), thereby activating your service contract. If you are just
downloading a later release (error correction, e.g. 5.0.1, 5.0.2 etc.), you do
not need a new license number.

74 You can find further information in the online help under “Technical
support”.
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1 Einfuhrung

Wir gehen im Folgenden davon aus, dass Sie
¢ sich mit Ihrem Windows®-Betriebssystem auskennen,
«  mit der Windows® Online-Hilfe umgehen kénnen.

1.1 Typografische Konventionen
Um eine eindeutige Kennzeichnung zu erhalten und eine bessere Lesbar-
keit zu erreichen, verwenden wir in dieser Kurzanleitung folgende Konventi-

onen:

i Steht fiir Achtung.

& Dieses Symbol weist auf ein wichtiges Detail oder eine Besonder-
heit hin.

A
A

Absatze mit diesem Symbol geben einen Tipp oder erlautern ein
interessantes Feature.

(i ) Dieses Symbol steht vor Links, die zu weiteren Informationen fiih-
ren.

Um einzelne Begriffe im Text hervorzuheben, wird kursive Schrift verwen-
det. Ebenfalls markiert sind die von Ihnen vorzunehmenden Eingaben, alle
Schaltflachen, Kontrollkdstchen, die Namen fiir Eingabefelder etc. Die
im Programm verwendeten Meniis, Befehle, Dialogfelder und -fenster
sowie Register und Gruppen im Menuband sind gleichfalls gekennzeich-
net.

s Dieses Symbol steht fiir weitere Informationen, die Sie in der
Online-Hilfe finden.

\@f Verwenden Sie Scﬁ%mt (in der Menuleiste dieser Hilfe), um die Schrift
dieser Hilfe zu vergroRern oder zu verkleinern. Jeder Klick auf das
Symbol schaltet zur nachsten von fiinf (festen) SchriftgrofRen weiter.
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1.2 Benutzung

Falls Sie noch nicht mit catman vertraut sind, empfehlen wir lhnen, nach der
Installation den Abschnitt Das Wichtigste in Kirze zu lesen.

2 Rufen Sie fur alle weiteren Fragen die kontextsensitive Online-Hilfe
von catman auf. In vielen Dialogen finden Sie direkt neben den Ein-
gabefeldern einen Link zum entsprechenden Thema in der Hilfe:

Falls Sie bei einem Problem nicht weiterkommen, finden Sie im Abschnitt
Technische Unterstitzung mehrere Moglichkeiten, direkt bei HBM Hilfestel-
lung zu erhalten.
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2 Systemvoraussetzungen

Fir den Betrieb von catman in der aktuellen Version bendtigen Sie einen

PC mit folgenden Voraussetzungen:

* Intel Pentium oder gleichwertiger Prozessor ab 1 GHz

+ Windows® 7 (32-Bit- oder 64-Bit-Version, Editionen Home, Professional
oder Ultimate), Windows® 8.1 (32-Bit- oder 64-Bit-Version) oder
Windows® 10 (aktuelle 32-Bit- oder 64-Bit-Version)

& Das Dateisystem sollte NTFS sein.

* Microsoft Internet Explorer Version 8.0 oder héher

* Mindestens 2048 MByte Hauptspeicher (RAM)

«  Grafikkarte bzw. Bildschirm mit einer Aufldésung von mindestens 1024 x
768 Pixel. Wir empfehlen, eine Auflésung von 1600 x 900 Pixel oder
hoher zu verwenden. Verwenden Sie bei kleinen Bildschirmen mit hohe-
ren Auflosungen bei Bedarf die Systemsteuerung von Windows
(Anzeige-Einstellungen), um die Darstellung von Text und anderen Bild-
schirmelementen zu vergrof3ern.

+ Ca. 1 GByte freien Speicher fir die Programminstallation, mindestens
weitere 1 GByte werden zum temporaren Speichern von Daten ben6-
tigt; hierflr kdnnen Sie jedoch auch ein anderes Laufwerk verwenden
(kein Netzlaufwerk)

*  Microsoft oder 100% kompatible Maus

« Eingerichteten Standarddrucker

« Eine der folgenden Schnittstellen fiir den Anschluss von Messgeraten':
+ USB, Ethernet (10/100 MBit), FireWire (IEEE 1394b2) oder RS-232

(COM1, COM2).

Fir catman PostProcess werden keine Schnittstellen benétigt.

2)  Bei FireWire werden nur Schnittstellen nach IEEE 1394b unterstiitzt. Die
HBM-Treiber fir die Schnittstelle (inklusive Adapter fir IP over FireWire)
mussen installiert werden (in der Installationssoftware von catman enthal-
ten).

®
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* Folgende Schriftarten miissen installiert sein:
* Arial (TT), Courier, MS Sans Serif, Small Fonts, Tahoma, Times New
Roman (TT), Verdana, Segoe Ul und Wingdings. Die Schriften wer-
den ublicherweise mit dem Windows-Betriebssystem installiert.

Hinweise

* Um Messdaten speichern zu kénnen, missen Sie iber gentigend freien
Speicher auf |hrer Festplatte verfligen. Verwenden Sie als Anhaltswert 8
Byte pro Messwert fiir eine Uberschlagsrechnung, d. h., bei 100.000
Werten werden fur 50 Kanale ca. 40 MByte bendtigt. Sie kdnnen das
Laufwerk, auf dem die Datei fiir den temporaren Messdatenspeicher
angelegt wird, Gber das Men( Datei — Optionen und Datenspeiche-
rung (Gruppe System) andern.

* Bei vielen Kanalen empfehlen wir, eine Feste SpeichergroRe fir den
temporaren Messdatenspeicher zu verwenden. Dies verbessert die
Geschwindigkeit der (temporaren) Datenaufzeichnung.

Siehe auch Datenspeicherung (Gruppe System)

» Falls kein freier Platz mehr auf der angegebenen Festplatte vorhanden
ist, wird die Messung abgebrochen. Sie sehen jedoch z. B. neben @ in
der Statuszeile, wie lange Sie noch messen kdnnen, bevor dies eintritt
(d = Tage, h = Stunden). Bei der Berechnung werden 100 MByte
Sicherheitsreserve einbezogen. Die Statusanzeige wird rot hinterlegt,
sobald der freie Platz unter 1 GByte sinkt.

* Die oben aufgefiihrten Voraussetzungen sind ausreichend, wenn Sie
wenige Kanale bei geringeren Messraten messen und auch nur wenige
grafische Ausgaben verwenden. Um bei vielen Mess- oder Berech-
nungskanélen oder komplexen grafischen Ausgaben und hohen Mess-
raten storungsfrei arbeiten zu kdnnen, missen Sie entsprechend leis-
tungsfahigere PC-Hardware verwenden.
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2.1 Optionen fiir die Datenspeicherung

Temporarer Messdatenspeicher
i) Siehe auch Systemvoraussetzungen, catman-Arbeitsverzeichnis

Um die anfallenden Messdaten so lange speichern zu kdnnen, bis Sie Uber
die weitere Verwendung entschieden haben (am Ende der Messung),
benutzt catman einen temporaren Messdatenspeicher. In der Voreinstellung
wird dazu eine spezielle Datei im catman-Arbeitsverzeichnis erstellt. Falls
der Pfad fir dieses Benutzerverzeichnis ein Netzwerkpfad ist, erhalten Sie
beim Start von catman den Hinweis, dass dies nicht zulassig ist. Geben Sie
dann im folgenden Dialog einen lokalen Pfad (einen Ordner auf der Fest-
platte lhres PCs) an, catman legt dann alle benétigten Dateien in diesem
Pfad an.

\/@”; Bei mehreren PC-Benutzern mit verschiedenen Windows-Konten
(Benutzernamen) empfehlen wir, eine Datei fiir alle Benutzer zu ver-
wenden, um nicht unnétig viel Platz fur diese Dateien zu reservie-
ren. Stellen Sie jedoch sicher, dass ein Verzeichnis gewahlt wird,
auf das alle Benutzer lesend und schreibend zugreifen kdnnen.
Geben Sie dieses Verzeichnis bei allen Benutzern von catman an.

Bei der Verwendung eines Betriebssystems mit NTFS-Dateisystem kann
diese Datei so lange dynamisch wachsen, wie freier Speicherplatz auf der
Festplatte zur Verfligung steht. Es kdnnen daher alle Daten erfasst und
nach der Messung in eine ,normale“ Datei exportiert werden. Die wahrend
des Startens von catman angezeigte Statusmeldung ,, Temporarer Messda-
tenspeicher wird eingerichtet” bedeutet, dass diese spezielle Datei initiali-
siert wird.

Falls das Dateisystem lhrer Festplatte nicht NTFS ist, miissen Sie
eine Feste SpeichergroBe verwenden und die GroRe fir den tem-
poraren Messdatenspeicher festlegen. Die Anzahl von Messwerten,
die Sie bei lhrer Konfiguration (Anzahl Kanéle und SpeichergréRe)
dann pro Kanal maximal erfassen kdnnen, wird angezeigt.
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Verwenden Sie als Anhaltswert fiir eine Uberschlagsrechnung der GréRe
der temporaren Datei 8 Byte pro Messwert, d. h., bei 1.000.000 Werten
(knapp 7 Minuten bei 2.400 Hz Messrate) werden fur 50 Kanale ca.

400 MByte benétigt.

Falls kein freier Platz mehr auf der angegebenen Festplatte vorhan-
den ist, wird die Messung abgebrochen. Sie sehen jedoch z. B.

-

neben @ in der Statuszeile, wie lange Sie noch messen kdnnen,
bevor dies eintritt (d = Tage, h = Stunden). Bei der Berechnung wer-
den 100 MB Sicherheitsreserve einbezogen. Die Statusanzeige wird
rot hinterlegt, sobald der freie Platz unter 1 GB sinkt.

Wie erkennen Sie das Dateisystem lhrer Festplatte?

Rufen Sie im Hauptverzeichnis der Festplatte (z. B. c:\) das Kontextmenii
Eigenschaften auf. Im folgenden Dialog ist in der dritten Zeile das verwen-
dete Dateisystem angegeben.

& Falls die Festplatte Ihres PCs nicht bereits ab Werk mit NTFS for-
matiert wurde, so empfehlen wir, dies nachtraglich vorzunehmen. In
der Regel stellt der PC-Lieferant dazu ein Konvertierungsprogramm
zur Verfigung. Andernfalls versuchen Sie CONVERT.EXE (im
Unterverzeichnis SYSTEM32 von Windows) mit den Parametern c :
/fs:ntfs zu starten, falls c das zu konvertierende Laufwerk ist
(CONVERT.EXE c: /fs:ntfs).

Die Konvertierung erfolgt ohne Datenverlust, Sie sollten jedoch aus
Sicherheitsgriinden vorher ein Backup lhrer Festplatte erstellen.

2.2 catman-Arbeitsverzeichnis

Das catman-Arbeitsverzeichnis darf nicht auf einem Netzlaufwerk
angelegt werden.

Nach der Installation von catman werden alle weiteren von catman benétig-
ten Dateien und Verzeichnisse z. B. flr die Sensordatenbank, das Spei-
chern von Daten oder Projekten und der temporare Messdatenspeicher im
catman-Arbeitsverzeichnis angelegt. Einige dieser Verzeichnisse bzw.
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Pfade kdnnen Sie mit den entsprechenden Optionen andern. Allerdings
wird das catman-Arbeitsverzeichnis z. B. auch fiir die Zwischenspeicherung
von Daten bei Berechnungen benétigt und enthalt die Autosequenz-Bei-
spiele. In der Voreinstellung wird das catman-Arbeitsverzeichnis im Ver-
zeichnis ,Eigene Dateien\HBM" des unter Windows angemeldeten Benut-
zers erstellt. Falls dies ein Netzwerkpfad ist, erhalten Sie bereits beim Start
von catman den Hinweis, dass dies nicht zulassig ist. Mit dieser Option kon-
nen Sie gezielt ein Verzeichnis fiir die Speicherung der von catman benétig-
ten Daten auswahlen.

NI

Geben Sie ein fir alle Benutzer freigegebenes Verzeichnis an, falls
mehrere Benutzer, die sich unter verschiedenen Namen bei
Windows anmelden, die gleichen Einstellungen verwenden sollen.
Andernfalls geniigt es, wenn Sie flr alle Benutzer die gleiche Sens-
ordatenbank (siehe Online-Hilfe, Optionen fiir Sensoren in den Pro-
grammoptionen) und eventuell den gleichen Pfad fur den tempora-

ren Messdatenspeicher festlegen.

\
SN
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3 Installation/Upgrade

(i) Siehe auch Lizenzierung und Registrierung

& Die Installation erfordert Administratorrechte. Wir empfehlen, alle
geodffneten Programme zu schliefen. Nach der Installation kann ein
Neustart von Windows erforderlich sein.

Bitte legen Sie die DVD in Ihr Laufwerk ein. In der Standardkonfiguration
offnet Windows automatisch die DVD, und es erscheint das Startfenster.
Sollten Sie die Windows-Autostartfunktion deaktiviert haben oder die Instal-
lationsdateien Uber einen Download erhalten haben, so suchen Sie bitte die
Datei ,Start“ bzw. ,Start.exe” (Hauptverzeichnis der DVD bzw. des Down-
loads) und doppelklicken Sie auf das zugehdrige Symbol, um das Startfens-
ter zu erhalten.

Wahlen Sie im Startfenster rechts oben bei Sprache die Installationsspra-

che aus.

Klicken Sie auf catman installieren und folgen Sie den Anweisungen des

Setup-Programms. Lesen Sie die Lizenzvereinbarungen durch und geben

Sie das Verzeichnis an, in das die Software installiert werden soll: Bestati-

gen Sie das vorgeschlagene Zielverzeichnis oder klicken Sie auf Durchsu-

chen und wahlen Sie das gewiinschte aus. Das Setup-Programm legt —
falls notwendig — das von Ihnen bestimmte Verzeichnis neu an und kopiert
dann alle Dateien dorthin. Im nachsten Schritt konnen Sie optional zu instal-
lierende Komponenten auswahlen:

+  HBM-USB-Treiber installieren: Der Treiber wird nur benétigt, wenn Sie
das HBM-Gerat MGCplus mit CP22/42 (iber eine USB-Schnittstelle
Ihres PCs betreiben mdchten. Es werden zunéachst nur die bendtigten
Dateien kopiert, erst bei Anschluss eines Gerates wird dann der Treiber
vom Betriebssystem (automatisch) vollstandig installiert.

Siehe auch Hinweise zur USB-Schnittstelle

* FireWire-Treiber: Die Treiber werden nur bendtigt, wenn Sie Quan-
tumX/SomatXR-Module uber eine FireWire-Schnittstelle Ihres PCs
betreiben mochten. Fir die Verbindung eines CX27- oder MX-Moduls
mit C-Funktionalitét (z. B. MX471C) Giber Ethernet an den PC und Uber
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FireWire an weitere QuantumX/SomatXR-Module wird der Treiber nicht
bendtigt.
Siehe auch Hinweise zur FireWire-Schnittstelle (IEEE 1394)

CANHEADdirect-Treiber: Der Treiber wird nur benétigt, wenn Sie
CANHEAD®-Module iiber den USB-zu-CAN-Adapter (Peak) betreiben
mochten.

Siehe auch Hinweise zur CAN-Bus-Schnittstelle (CANHEADdirect)
NTP-Zeitserver: Die Installation ist nur bei QuantumX/SomatXR,
MGCplus, PMX, DMP41 und FS22 BraggMETERnN sinnvoll, da diese
dann uber den Zeitserver mit exakten Zeitangaben versorgt werden
kénnen. Es wird der Zeitserver von Meinberg installiert. Eine Synchroni-
sation des Zeitservers mit einem Zeitserver im Internet ist nicht erforder-
lich und wird durch die automatische Installation auch nicht eingerichtet,
der Zeitserver dient lediglich zur Synchronisation der an der Messung
beteiligten Geréte.

Sie kdnnen den NTP-Zeitserver aber auch nachtraglich oder auf einem
anderen PC installieren, siehe auch http://www.meinberg.de und ,Syn-
chronisation mehrerer Gerate“ in der Online-Hilfe.
Legacy-TEDS-Editor installieren: Die Installation ist normalerweise
nicht notwendig, da Sie Uber die Sensordatenbank sowohl neue (leere)
TEDS-Module beschreiben als auch vorhandene einfach modifizieren
kénnen, siehe ,Verwenden von Aufnehmern mit TEDS" in der Online-
Hilfe. Der Editor wird nur benétigt, wenn Sie TEDS-Inhalte wie in der
TEDS-Norm spezifiziert ansehen oder editieren mdchten.

Vor dem eigentlichen Kopiervorgang zeigt Ihnen das Installationsprogramm
noch eine Zusammenfassung der durchzufiihrenden Arbeiten, die Sie mit
Installieren bestatigen muissen.

Hinweise

catman

Wir empfehlen, catman direkt nach der Installation einmal mit Administ-
ratorrechten zu starten. Geben Sie die Lizenznummer ein und schlieRen
Sie die zu betreibenden Gerate an, damit die Treiber vollstandig instal-
liert werden (erfordert Administratorrechte).

Die nachtréagliche Installation eines Treibers kann mehrere Minuten dau-
ern, da Windows zunachst versucht, den Treiber Gber das Internet zu
finden. Wir empfehlen deshalb, die Installation Gber das entsprechende
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Programm fiir den Treiber vorzunehmen (siehe die folgenden
Abschnitte ,Hinweise ... “ zur jeweiligen Schnittstelle).

3.1 Hinweise zur Ethernet-Schnittstelle

Windows Firewall

Falls Sie tber die Ethernet-Schnittstelle eine Verbindung zu einem HBM-
Gerat aufnehmen, wird dies meist von der Windows Firewall oder von der
Firewall Ihres Virenschutzprogramms geblockt. Fir die Windows-Firewall
wird bei der Installation von catman eine Ausnahme definiert. Geben Sie bei
anderen Programmen den Zugriff fiir catmanEasy oder catmanEasy-AP
frei.

Andere Firewall
Geben Sie je nach angeschlossenen Geraten folgende Ports frei:

*  QuantumX/SomatXR: TCP-Ports 80, 5001 und 7411, UDP fir die Ports
1200, 1201, UDP-Multicast fiir die Ports 1300, 1301, 31416 und 31417,
fur die CX27 die TCP-Ports ab 50 000,

*  MGCplus mit CP22/42: TCP-Port 7 (kein UDP bzw. Multicast vorhan-
den),
MGCplus mit CP52: TCP-Ports 7 und 80, UDP-Multicast fiir die Ports
31416 und 31417,

«  DMP41: TCP-Port 1234, UDP-Multicast fiir die Ports 31 416 und 31 417,
*  PMX: TCP-Port 55.000, UDP-Multicast fiir die Ports 31416 und 31417,
*  FS22 BraggMETER: TCP-Ports 3500 und 3365,

» Kistler System 2000: UDP fur die Ports 8888 und 8889,

« Kistler KiRoad: TCP-Ports 6155 und 6158, UDP fiir den Port 6156.

Verbindung mit MGCplus iiber WLAN

Falls Sie die Verbindung zum MGCplus nicht Gber Kabel, sondern Uber ein
WLAN herstellen, kann es bei langsamen Netzwerken zum Abbruch der
Verbindung (Timeout) kommen. Setzen Sie in diesen Fallen die Wartezeit
fur die Abfrage der Ausgangspuffer auf einen hoheren Wert.
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Anderungen an der Registry mit dem Programm regedit.exe sollten
nur von erfahrenen Anwendern und nach einem Backup der bisheri-
gen Registry durchgefiihrt werden, da unter Umstanden schwerwie-
gende Fehler in Windows die Folge sein kdnnen. Lassen Sie ggf.
die Anderung von lhrem Administrator durchfiihren.

omm

Legen Sie unter HKEY_LOCAL_MACHINE/SOFTWARE/HBM/CAT-
MAN/SETTINGS die neue Zeichenfolge MGCGetFifoTimeout an und
geben Sie einen Wert von tiber 500 (ms) an, z. B. 1500.

3.2 Hinweise zur USB-Schnittstelle

Sie konnen den USB-Treiber bei der Installation von catman ebenfalls ins-
tallieren (Voreinstellung: USB-Treiber wird installiert). Falls dies nicht erfolgt
ist, kdnnen Sie den Treiber auch nachtraglich installieren, siehe die fol-
gende Beschreibung.

Information zur Treiberversion

Der mit catman gelieferte Treiber fiir MGCplus wurde 2010 tberarbeitet und
liegt in der Version 3.3.3.2 vom 25.3.2010 vor: Er ist signiert (nétig fur die
64-Bit-Versionen von Windows) und bendtigt kein Setup-Programm mehr,
falls ein Gerat mit einem anderen USB-Anschluss lhres PCs verbunden
wird. Sollte beim AnschlieBen eines Gerates ein Windows-Dialog erschei-
nen mit der Meldung, dass neue Hardware erkannt wurde, so lassen Sie die
Software automatisch installieren, da Windows den Treiber dann selbst-
standig findet. Nur bei Anschluss eines (neuen) USB-Hubs muss abhangig
von lhrem System eventuell eine vollstandige Installation durchgefihrt wer-
den. Gehen Sie in diesem Fall so vor, wie unten fiir die Installation beschrie-
ben.

Treiberaktualisierung, Kontrolle der Treiberversion

Falls Sie bereits eine altere Installation von catman auf Inrem PC hatten,
bleibt eventuell ein alter Treiber bei einer Neuinstallation erhalten. Um einen
neuen Treiber zu installieren, muss der alte Treiber zunachst deinstalliert
werden. Normalerweise wird dies vom Installationsprogramm durchgefuhrt.
Falls die nicht erfolgt ist, z. B. weil die Installation abgebrochen wurde, mis-
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sen Sie dies manuell durchfiihren (Administratorrechte erforderlich). Die
aktuell installierte Version kénnen Sie bei den neueren Treibern auch Uber
Systemsteuerung — Programme und Funktion bzw. bei Windows 10
Uber Einstellungen — System — Apps & Features sehen. Verwenden
Sie ansonsten die nachfolgend beschriebene Prozedur bis zu Schritt 4.

Vorgehensweise zur Deinstallation eines alten Treibers

1.
2.
3.

6.
7.

SchlieRen Sie ein MGCplus Gber USB an.
Rufen Sie die Systemsteuerung von Windows auf.

Doppelklicken Sie auf ,Gerate-Manager®. (Schalten Sie ggf. die Anzeige
um.)

Alte Treiber werden als Untereintrag zu ,USB-Controller* angezeigt,
neuere als eigener Eintrag. Klicken Sie mit der rechten Maustaste auf
den Eintrag und wéhlen Sie Eigenschaften aus.

Die aktuell installierte Version wird in diesem Dialog angezeigt.

Klicken Sie auf dem Register Treiber auf Treiber deinstallieren und
warten Sie, bis die Deinstallation beendet ist.

Ziehen Sie den USB-Stecker zum MGCplus heraus.
Warten Sie ca. 10 Sekunden, bevor Sie den neuen Treiber installieren.

Vorgehensweise zur (nachtraglichen) Installation eines USB-Treibers

1.

14

Gehen Sie zum Verzeichnis ,DriverSetups® im Installationsverzeichnis
von catman.

Doppelklicken Sie auf ,HBM USB 10 Driver Setup.exe®.

Lesen Sie die Lizenzvereinbarungen durch und folgen Sie den Anwei-
sungen des Setup-Programms.

Das Setup-Programm kopiert die notwendigen Dateien in die entspre-
chenden Windows-Unterverzeichnisse und richtet den Treiber ein.
Stecken Sie den USB-Stecker zum MGCplus ein.

Falls die Frage erscheint, ob eine Verbindung zu Windows Update her-
gestellt werden soll, aktivieren Sie Nein, diesmal nicht und klicken Sie
auf Weiter.
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6. Aktivieren Sie Software automatisch installieren.
Windows aktualisiert dann die notwendigen Dateien. Warten Sie, bis die
Meldung ,Neue Hardware gefunden® in der Taskleiste von Windows
erscheint. Starten Sie erst danach catman.

Der neue Treiber wird als eigener Eintrag unter ,HBM USB Devices" im
Gerate-Manager angezeigt, sobald ein Gerat angeschlossen ist. AulRerdem
werden die Treiber in der Liste der installierten Programme angezeigt (Sys-
temsteuerung — Programme und Funktion bzw. bei Windows 10 Ein-
stellungen — System — Apps & Features).

3.3 Hinweise zur FireWire-Schnittstelle (IEEE 1394)

Die erforderlichen FireWire-Treiber kdnnen bei der Installation von catman
ebenfalls installiert werden (optionale Komponente). Falls dies nicht erfolgt
ist, kbnnen Sie die Treiber auch nachtraglich installieren, siehe die folgende
Beschreibung.

& Die Installation erfordert Administratorrechte unter Windows. Falls
Sie eine Einsteckkarte flir die FireWire-Schnittstelle verwenden,
sollten Sie die Karte vor der Installation in den PC einstecken, dann
wird der HBM-Treiber fiir die Karte automatisch aktiviert.

Fir die FireWire-Schnittstelle (IEEE 1394b) der QuantumX/SomatXR-
Module missen Sie den von HBM mitgelieferten Treiber verwenden. Sie
koénnen jedoch jederzeit wieder zum Originaltreiber Ihrer Schnittstelle
umschalten.

Starten Sie nach der Installation catman wie Ublich und geben Sie im Dialog
Neues Messprojekt vorbereiten als Schnittstelle FireWire an.

IP-over-FireWire (HBM IEEE1394 IP Adapter)

Ab Version 3.4 erfolgt die Kommunikation mit den QuantumX/SomatXR-
Modulen auch bei FireWire ahnlich wie bei Ethernet. Dazu wird eine virtu-
elle Schnittstelle fir jede physikalisch vorhandene FireWire-Schnittstelle
eingerichtet: IP over FireWire. Maximal zwei Adapter werden angelegt und
sind in den Netzwerkverbindungen sichtbar. Als IP-Adresse werden
24.0.0.1 und 25.0.0.1 verwendet, daher heiflden die Schnittstellen-Adapter
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IP over FireWire 24 und IP over FireWire 25. (Letzterer ist nur vorhanden,
falls mehr als eine physikalische Schnittstelle im PC eingebaut ist1). Fir die
Schnittstelle IP-over-FireWire ist nur das Internetprotokoll TCP/IP (IPv4)
erforderlich, der Client fir Microsoft-Netzwerke oder der QoS-Paketplaner
werden nicht bendétigt.

Vorgehensweise zur (nachtraglichen) Installation der Treiber

1. Gehen Sie zum Verzeichnis ,DriverSetups” im Installationsverzeichnis
von catman.
Doppelklicken Sie auf ,HBM IEEE1394 Driver Setup.exe®.

3. Lesen Sie die Lizenzvereinbarungen durch und folgen Sie den Anwei-
sungen des Setup-Programms.
Das Setup-Programm kopiert die notwendigen Dateien in die entspre-
chenden Windows-Unterverzeichnisse und richtet die Treiber und IP-
over-FireWire-Adapter ein.

N,
D

Prufen Sie bei Verbindungsproblemen, ob der Schnittstellen-Adap-
ter IP-over-FireWire 24 eingerichtet wurde (Windows-Systemsteue-
rung — Netzwerk- und Freigabecenter — Adaptereinstellungen
andern). Falls nicht, schlief3en Sie ein Gerat an und doppelklicken
Sie auf ,HBM IEEE1394 IP Adapter Wizard.exe" im Verzeichnis
,DriverSetups".

Aktivierung des HBM-Treibers bei mehreren Schnittstellen
(i} Der HBM-Treiber ist ein modifizierter Thesycon-Treiber.

Falls Ihr PC uber mehr als eine FireWire-Schnittstelle verfigt, miissen Sie

festlegen, fir welche Schnittstelle der Treiber verwendet werden soll.

1. Starten Sie das Programm ,t1394bus_installwizard.exe” (Thesycon
T1394bus Setup Wizard) im Verzeichnis ,HBM IEEE1394 Treiber®. Das
Verzeichnis wird innerhalb des Verzeichnisses ,HBM*“ im Windows-Ord-

) Eine FireWire-Karte kann zwar z. B. 3 Anschliisse haben, wird jedoch meist
trotzdem nur als eine Schnittstelle im System angemeldet. In diesem Fall
wird auch nur ein IP-over-FireWire-Adapter eingerichtet (HBM IEEE1394 IP
Adapter).

16 A01235_15_Y00_00 HBM: public catman®



I
]
<

ner fir Programme angelegt (meist ,,C:\Programme\HBM\HBM
IEEE1394 Treiber”).

Wahlen Sie den gewiinschten IEEE 1394 Host Controller durch Ankli-
cken in der Liste aus. Der ,Thesycon T1394bus Setup Wizard“ zeigt alle
im PC befindlichen 1394 _OHCI_HostController an. Falls Sie mehrere
Adapter haben, kdnnen Sie einen davon auswabhlen. Klicken Sie
andernfalls auf den ersten Eintrag.

Klicken Sie auf Switch to T1394bus driver, um den HBM-Treiber zu
installieren.

Schlie®en Sie das Programm ,Thesycon T1394bus Setup Wizard*“. Der
Treiber ist damit installiert und bereit zur Verwendung.

Falls Sie den Originaltreiber Ihrer FireWire-Schnittstelle wieder aktivieren
mochten, starten Sie den ,Thesycon T1394bus Setup Wizard“ erneut, wah-
len Sie den betreffenden IEEE 1394 Host Controller aus und klicken Sie auf
Switch to in-box T1394 driver. Damit wird der HBM-Treiber deaktiviert,
aber nicht deinstalliert. Sie kdnnen jederzeit zwischen beiden Treibern
umschalten.

Remove T1394bus driver from system entfernt den HBM-Treiber voll-
standig von lhrem PC.

Installieren des geratespezifischen Treibers

1.

SchlielRen Sie das MX-Modul an.

Nach kurzer Zeit 6ffnet sich ein Windows-Dialog mit der Meldung, dass
neue Hardware erkannt wurde, und fragt, ob ein Treiber im Internet
gesucht werden soll.

Aktivieren Sie Nein, diesmal nicht und klicken Sie auf Weiter.
Aktivieren Sie Software automatisch installieren.

Windows aktualisiert dann die notwendigen Dateien. Warten Sie, bis die
Meldung ,Neue Hardware gefunden® in der Taskleiste von Windows
erscheint. Starten Sie erst danach catman.
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3.4 Hinweise zur CAN-Bus-Schnittstelle bei
CANHEADdirect

Die erforderlichen CANHEADdirect-Treiber konnen bei der Installation von
catman ebenfalls installiert werden (optionale Komponente). Falls dies nicht
erfolgt ist, kdnnen Sie die Treiber auch nachtraglich installieren, siehe die
folgende Beschreibung.

Um die CAN-Bus-Schnittstelle am PC zum direkten Anschluss von CAN-
HEAD®-Modulen zu erhalten, miissen Sie den USB-zu-CAN-Adapter von
Peak installieren und ggf. ein CAN-Netz konfigurieren. Starten Sie nach der
Installation catman wie Ublich und geben Sie im Dialog Neues Messprojekt
vorbereiten als Schnittstelle CANHEADdirect an.

Vorgehensweise zur (nachtraglichen) Installation des Treibers

1. Gehen Sie zum Verzeichnis ,DriverSetups” im Installationsverzeichnis
von catman.

2. Doppelklicken Sie auf ,HBM Peak Driver Setup.exe”.

3. Lesen Sie die Lizenzvereinbarungen durch und folgen Sie den Anwei-
sungen des Setup-Programmes.

Das Setup-Programm kopiert die notwendigen Dateien in die entspre-
chenden Windows-Unterverzeichnisse und richtet den Treiber ein.

USB-zu-CAN-Adapter einrichten

1. Stecken Sie den USB-zu-CAN-Adapter an eine freie USB-Schnittstelle
Ihres PCs.

2. Schalten Sie die Stromversorgung des Adapters ein (die beiden LEDs
auf der Anschlussseite missen griin leuchten).

Nach kurzer Zeit 6ffnet sich ein Windows-Dialog mit der Meldung, dass
neue Hardware erkannt wurde, und fragt, ob ein Treiber im Internet
gesucht werden soll.

3. Aktivieren Sie Nein, diesmal nicht und klicken Sie auf Weiter.

4. Lassen Sie im nachsten Fenster die Software von einer Liste oder
bestimmten Quelle installieren.
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5. Geben Sie den Pfad zur Datei PCAN_USB.SYS an (Verzeichnis CAN-
HEADdirect im Installationsverzeichnis von catman). Windows kopiert
die notwendigen Dateien dann in die entsprechenden Windows-Unter-
verzeichnisse.

CAN-Netz konfigurieren

Die Software von PEAK ermdglicht es, fiir verschiedene Anwendungen
mehrere CAN-Netze zu definieren, die z. B. unterschiedliche Bitraten ver-
wenden, auch wenn nur ein Adapter vorhanden ist. Je nachdem, welches
Netz Sie spater auswahlen, wird dann die entsprechende Bitrate benutzt,
ohne dass Sie die Bitrate am Adapter selbst jedes Mal umsetzen missen.
Zusatzlich enthalt die PEAK-Software Programme zur Statusanzeige und
zum Testen von CAN-Bus-Geraten tber CAN-Messages.

Bei der Installation von catman wird bereits ein Netz fiir die CANHEAD®-
Module eingerichtet, falls der Adapter wahrend der Installation angeschlos-
sen war. SchlieRen Sie andernfalls den Adapter an und starten Sie das Pro-
gramm NetCreator.bat im Verzeichnis CANHEADdirect (im Installationsver-
zeichnis von catman), um das Netz CANHEAD_DIRECT automatisch
einrichten zu lassen. Die zu verwendende Bitrate von 250 kBit/s wird dabei
ebenfalls gesetzt.
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4 Deinstallation

Zur Deinstallation von catman 6ffnen Sie bitte die Liste der installierten
Windows-Anwendungen. Wéhlen Sie dort dann die catman-Installation aus.

Liste der Anwendungen unter Windows 10 aufrufen

Geben Sie im Suchfeld der Taskleiste Programm d@ndern oder entfernen
ein und rufen Sie das vorgeschlagene Programm zur Systemsteuerung auf.

Alternativ kénnen Sie auch Einstellungen — System — Apps & Features
im Startmeni bzw. Alle Einstellungen — System — Apps & Features im
Info-Center verwenden.

Liste der Anwendungen unter Windows 8/8.1 aufrufen

Rufen Sie Uiber das Menii Charms im Windows-Desktop (nicht in der
Kachelansicht) und Einstellungen — Systemsteuerung auf. Doppelkli-
cken Sie auf Programme und Features (Anzeige: Kleine Symbole) oder
Programm deinstallieren (Anzeige: Kategorie).

Liste der Anwendungen unter Windows 7 aufrufen

Rufen Sie Uber das Startmeni von Windows Systemsteuerung — Netz-
werk- und Freigabecenter auf. Doppelklicken Sie auf Programme und
Funktionen (Anzeige: Kleine Symbole) oder Programm deinstallieren
(Anzeige: Kategorie).

Hinweise

« Es werden nur die bei der Installation angelegten Dateien gel6scht,
wahrend des Einsatzes von catman entstandene Dateien werden nicht
entfernt.

« Zusammen mit catman installierte Hilfsprogramme wie z. B. der NTP-
Zeitserver werden nicht automatisch deinstalliert. Falls Sie die Anwen-
dungen nicht mehr benétigen, deinstallieren Sie sie Uber die System-
steuerung von Windows.

* Programme oder Treiber, die fir spezielle Schnittstellen wie USB, CAN-
Bus oder FireWire installiert wurden, werden ebenfalls nicht automa-
tisch deinstalliert. Verwenden Sie auch hierzu die Systemsteuerung von
Windows.
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5 Lizenzierung und Registrierung

& Siehe auch https://www.hbm.com/terms/software zu den Lizenzbe-
dingungen fir Software (EULA)

Beim ersten Start des Programms miissen Sie lhren Namen und lhre Firma
sowie die auf der DVD angegebene Lizenznummer eingeben. Falls Sie
keine Lizenznummer angeben, wird catman im Evaluierungsmodus gestar-
tet (maximal 25 Starts mit allen Funktionen sind moglich).

Klicken Sie im Startfenster von catman auf Info, falls Sie:

» lhre Lizenznummer spéater eingeben méchten.

* Den Namen oder die Firma andern mdéchten.

« Eine Datei mit Informationen zu lhrem PC-System (System-Info-Datei)
fur den HBM-Support erzeugen mdchten.

+ Die freigeschalteten Module sehen mochten, z. B. EasyMath (Mathe-
matik und Autosequenzen).

» Die Release Notes (in Englischer Sprache) fir die aktuelle Version
sehen mochten.
Siehe auch Abschnitt ,Was ist neu in catman? (Historie) in der Online-
Hilfe.

Im Fenster werden auf der rechten Seite die aktuellen Lizenzdaten ange-
zeigt, mit Andern kénnen Sie alle Angaben verandern.

Hinweise zum Panelobjekt Karte (nur bei catman AP, catman PostPro-
cess oder Zusatzmodul EasyRoadload verfiigbar)

Das Objekt 1adt aus dem Internet eine Kartenansicht, die von Google Ire-
land Ltd. zur Verfigung gestellt wird. Bei der Anfrage werden keine Benut-
zerinformationen oder PC-Kennwerte auler der anfragenden IP-Adresse
an Google Ubermittelt.

Die Verwendung der Karten ist nur in Verbindung mit catman zulassig. Das
Objekt steht aufgrund lizenzrechtlicher Einschrankungen nicht in allen Lan-
dern zur Verfugung, z. B. nicht in China oder Nordkorea. Sie kénnen aller-
dings auf die Verwendung von Baidu-Karten umstellen, wenn Sie einen
Baidu-Account besitzen. Detaillierte Informationen finden Sie in der
Knowledge Base unter ,Working with Baidu Maps in China“ und
http://Ibsyun.baidu.com/index.php?title=webapi.

®
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Registrierung und Aktivierung der Softwarewartung

Bitte registrieren Sie sich mit einer E-Mail an systems@hbm.com, um lhren

Wartungsvertrag zu aktivieren. Die Registrierung wird von HBM benétigt,

um sicherzustellen, dass Sie bei Erscheinen einer neuen Version benach-

richtigt werden kdnnen und die dafiir nétige Lizenznummer erhalten. Sie

erhalten nach einer erfolgreichen Registrierung von HBM per E-Mail auch

die entsprechenden Telefonnummern flr einen direkten Zugang zum cat-

man-Support in Ihrer Region. Folgende Informationen werden bendtigt:

1. Die Programmbezeichnung (catman Easy oder catman AP oder catman
PostProcess).

2. lhre aktuelle Lizenznummer.

3. Der Firmenname.

4. lhr Name und eventuell Ihre Abteilung.

5. lhre E-Mail-Adresse.

& Eine Ummeldung auf einen anderen Namen und/oder eine andere

E-Mail-Adresse ist jederzeit moglich.

Modul freischalten

1. Klicken Sie im Startfenster von catman auf Optionen.

2. Aktivieren Sie Uber Programmfunktionen (Gruppe System) das
erworbene Modul.

3. Geben Sie im folgenden Dialog die Lizenznummer ein, die Sie fiir das
Modul erhalten haben.

& Die Lizenznummer muss nur bei der ersten Aktivierung eingegeben
werden. Falls Sie das Modul zeitweise nicht bendtigen, kdnnen Sie
es Uber das Menu Datei — Optionen und Programmfunktionen
(Gruppe System) deaktivieren. Fir die erneute Aktivierung gentigt
ein Klick in das entsprechende Kastchen.

Alle freigeschalteten Module und die Basislizenznummer werden nach
einem Klick auf Info im Startfenster oder auf Uber catman (Menii Hilfe) im
Programm angezeigt.
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6 Das Wichtigste in Kiirze

catman® ist die Messtechniksoftware zu den HBM-Geraten QuantumsX,
SomatXR, MGCplus, CANHEAD®, PMX, DMP41, eDAQ (SoMat) und den
FS22 BraggMETERnN SI/DlI fiir die Messung mit optischen DMS. Mit ihr kén-
nen Sie vielfaltige Messaufgaben schnell und einfach ohne jeden Program-
mieraufwand erledigen. AuRer den Geraten von HBM kdnnen Sie auch ein
GPS-System, die Vaisala Wetterstation WXT520, einen GOM Testing Cont-
roller (ARAMIS) zur optischen Dehnungsmessung oder Kistler RoaDyn-
Sensoren (System 2000 bzw. KiRoad) in catman einbinden.

catman erkennt nicht nur die Konfiguration der angeschlossenen HBM-
Messgerate, dank des optimalen Zusammenspiels von Hard- und Software
wird z. B. bei TEDS-Aufnehmern die gesamte Messkette automatisch beim
Start konfiguriert. Bei Messkanalen mit herkdémmlichen Aufnehmern ver-
wenden Sie die integrierte catman-Sensordatenbank und weisen den ein-
zelnen Kanélen die verwendeten Aufnehmer einfach zu. Die Sensordaten-
bank enthalt bereits alle HBM-Aufnehmer als Vorlage und typische
Sensoren wie Thermoelemente, Pt100, Spannungs- oder Stromquellen,
|asst sich jedoch auch leicht um Ihre Aufnehmer erweitern. CAN-Signale
lassen sich ebenfalls in die Sensordatenbank aufnehmen und CAN-Emp-
fangskanalen zuweisen. Sie kdnnen Sensordaten aus der Sensordaten-
bank auch in TEDS-Module schreiben oder die Daten eines TEDS-Moduls
in die Sensordatenbank Uibernehmen.

Verwenden Sie die Voreinstellungen von catman oder definieren Sie eigene
Messablaufe, sogenannte Messjobs: Messrate, Start- und/oder Stopptrigger
inklusive Vorlauf- und Nachlaufzeit festlegen, Zeitpunkte fur Start und Stopp
wahlen oder die Messung manuell starten und stoppen. Die Einstellungen
lassen sich auch mischen, z. B. Start mit Trigger und Stopp nach einer
bestimmten Zeit oder Anzahl von Messwerten etc. Erzeugen Sie mit den
grafischen Objekten von catman eigene Visualisierungen: Grafiken, die
Ihnen die Messkurven wahrend der Messung anzeigen, Digital- oder Bal-
kenanzeigen und verschiedene weitere Objekte stehen zu lhrer Verfiigung.
Sie konnen jedoch auch hier die Voreinstellungen von catman verwenden
und sofort mit dem Messen beginnen. Auch wahrend der Messung kdnnen
Sie weitere Kanale in vorhandenen oder neuen Grafikobjekten darstellen
lassen.

catman® A01235_15_Y00_00 HBM: public 23



HBM

Die Basisversion catman Easy kénnen Sie mit zusatzlichen (kostenpflichti-
gen) Modulen erweitern. Die Version catman AP enthalt catman Easy und
die am haufigsten verwendeten Module.

Die Version catman PostProcess ist auf den Auswertemodus beschréankt
(kein Anschluss von Geraten und Erfassen von Messwerten mdglich).

Bitte registrieren Sie sich bei HBM, um lhren Wartungsvertrag zu
aktivieren. Die Registrierung wird von HBM benétigt, um sicherzu-
stellen, dass Sie bei Erscheinen einer neuen Version benachrichtigt
werden konnen und die dafir nétige Lizenznummer erhalten, siehe
Lizenzierung und Registrierung.

L)

6.1 Neues Messprojekt vorbereiten: Gerate-Suche

& Die Einstellungen der Gerate-Suche erreichen Sie im Menu Messen
des Startfensters von catman uber Geratetyp, Schnittstelle und
weitere Hardwareoptionen festlegen oder Giber das Meni Optio-
nen des Startfensters von catman und Neues Messprojekt vorbe-
reiten.

Beim Start eines neuen Messprojekts werden die bei den Einstellungen zur
Gerate-Suche aktivierten Schnittstellen nach den bei Geratetypen suchen
aktivierten Geraten durchsucht. Die Gerate missen eingeschaltet und
betriebsbereit sein, sonst werden sie nicht gefunden. Warten Sie daher
nach dem Einschalten der Geréate lange genug, bevor Sie ein neues Projekt
beginnen oder ein bestehendes laden.

Der gleichzeitige Anschluss unterschiedlicher HBM-Geréate wird von
catman nur eingeschrankt unterstiitzt: bei eDAQ/eDAQ-lite, DMP41,
PMX und CANHEADdirect kdnnen nur weitere Gerate des gleichen
Typs verwendet werden. QuantumX/SomatXR oder MGCplus kon-
nen Sie auch zusammen mit FS22 BraggMETERnN oder einem GOM
Testing Controller (ARAMIS) verwenden. Davon unabhangig kon-
nen Sie z. B. einen GPS-Empfanger tber Optionen und das Regis-
ter Zusatzliche Gerate oder den HBM-Geratemanager in das
Messprojekt einbeziehen.

s
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;@/\/ Lassen Sie nur die Schnittstellen durchsuchen, an denen Sie auch
ein Gerat angeschlossen haben.

6.2 HBM-Geratemanager verwenden

QuantumX/SomatXR-Module mit Firmware 4.0 oder héher, PMX sowie
MGCplus mit CP52 melden ihre IP-Adresse zyklisch im Netzwerk. Diese
Meldungen werden gesammelt und ausgewertet. Daher ist die am Gerat
eingestellte IP-Adresse unwichtig, alle im (Ethernet-)Netzwerk (oder bei
MX-Modulen auch Uber FireWire) erreichbaren Gerate werden gefunden.

Falls Sie alte MX-Module besitzen, miissen Sie die Firmware zuerst aktuali-
sieren.

Vorgehensweise

« Klicken Sie auf Neuer Modul-Scan, falls kein Gerat oder Modul auf
dem Register Gefundene Module angezeigt wird.
Alle Gerate bzw. Module werden auf dem Register Gefundene Module
aufgelistet, auch Module oder Geréate, mit denen keine Verbindung
maoglich ist.

+ Andern Sie bei einer Kennzeichnung mit ) die IP-Adresse.
Vor der Moduladresse wird £ eingeblendet, wenn das Gerat bzw.
Modul eingestellt werden und Messwerte liefern kann. In der Regel
mussen sich PC und Gerat dazu im gleichen Netzwerksegment befin-
den.

+ Falls bei QuantumX/SomatXR oder MGCplus mit CP52 in der Spalte
Firmware der Text ,.... Aktualisierung notwendig“ angezeigt wird, mus-
sen Sie das betreffende Gerat oder Modul aktualisieren.

A/
A

Falls Sie bereits einmal Gerate oder Module im Geratemanager
ausgewahlt und verwendet hatten, aktivieren Sie Zuletzt benutzte
Gerite verwenden im Startfenster (Menli Messen), um sich direkt
mit diesen Geréaten zu verbinden (ohne den Geratemanager erneut
anzuzeigen).
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Mehrere MX-Module werden anhand lhrer Namen sortiert und alphabetisch
aufsteigend in die Kanalliste ibernommen. Um PMX-Gerate alphabetisch
sortiert in die Kanalliste zu ibernehmen, gentigt es, wenn Sie die Liste im
HBM-Geratemanager sortieren: Klicken Sie vor dem Verbinden auf die
Spalte Name. QuantumX/SomatXR-Module, die tber ein Gateway ange-
schlossen sind, z. B. ein CX27-Modul oder Module mit C-Funktionalitat,

z. B. ein MX471C, werden in einer Baumstruktur unterhalb des Gateways
angezeigt.

MX471C als Gateway verwenden

Beginnen Sie ggf. ein Neues Messprojekt, um den HBM-Geratemanager
aufzurufen. Auf dem Register Moduleinstellungen @ndern kénnen Sie die
Gateway-Funktionalitat aktivieren. Die Funktion ist in der Voreinstellung
deaktiviert.
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7  Technische Unterstiitzung

& Bitte halten Sie in jedem Fall Ihre Lizenznummer griffbereit. Diese
finden Sie auf lhrer catman-DVD oder im Info-Fenster zu catman
(Meniipunkt Uber catman im Men(i Hilfe).

Sollten bei der Arbeit mit catman Probleme auftreten, bietet Ihnen der tech-
nische Support von HBM:

E-Mail-Unterstiitzung
info@hbm.com

Telefon-Unterstitzung

Die telefonische Unterstitzung ist von 9:00 bis 17:00 Uhr (MEZ) an allen
Werktagen verfigbar:

+49 6151 803-0

Fax-Unterstiitzung
+49 6151 803-9100

|

NS
A

Wir empfehlen, den Registrierungsdialog (siehe Lizenzierung und
Registrierung) auszufillen und die Daten an HBM zu senden. Sie
erhalten dann von HBM gesonderte Telefonnummern fiir den direk-
ten catman-Support. AuBerdem werden Sie — solange Ihr Wartungs-
bzw. Supportvertrag besteht — benachrichtigt, sobald eine neue Ver-
sion zur Verfugung steht, und erhalten so auch Ihre neue Lizenz-
nummer.

System-Info-Datei

Um dem HBM-Support Informationen Gber Ihr PC-System geben zu kén-
nen, erzeugen Sie bitte im Dialog mit den Lizenzangaben (Info im Start-
fenster oder Meniipunkt Uber catman im Menii Hilfe) eine System-Info-
Datei. Vor der Erzeugung der Datei CATMAN_SYSINFO.TXT kénnen Sie
den Dateipfad auswahlen, der Pfad wird zusatzlich nach der Erzeugung
noch einmal angezeigt.

®
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Folgende Méglichkeiten stehen Ilhnen ebenfalls zur Verfiigung

HBM-Support und Vertrieb weltweit
https://www.hbm.com/contact/worldwide/

Softwareaktualisierung von HBM herunterladen

https://www.hbm.com/Software

Bitte beachten Sie, dass neue Versionen (z. B. 5.0, 5.1 etc.) der Software
auch eine neue Lizenznummer benétigen. Registrieren Sie sich deshalb
(siehe Lizenzierung und Registrierung) und aktivieren Sie damit Ihren War-
tungsvertrag. Falls Sie lediglich ein neueres Release (Fehlerkorrektur, z. B.
5.0.1, 5.0.2 etc.) herunterladen, wird keine neue Lizenznummer benétigt.

74 Weitere Informationen finden Sie in der Online-Hilfe unter ,Techni-
sche Unterstiitzung®.
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1 Introduction

Nous supposons ci-aprés que

* vous connaissez bien votre systéme d'exploitation Windows® et que
vous savez

« utiliser I'aide en ligne Windows®.

1.1 Conventions typographiques

En vue d’obtenir un marquage clair et faciliter la lecture du document, les
conventions suivantes sont utilisées dans le présent guide rapide :

i signifie Attention !

& Ce symbole signale un détail important ou une particularité.

Les alinéas munis de ce symbole fournissent une astuce ou
expliquent une fonction intéressante.

i) Ce symbole se trouve devant des liens conduisant a des informa-
tions supplémentaires.

Les caracteres en italique permettent de faire ressortir certains termes du
texte. Le marquage suivant caractérise les données a entrer, tous les bou-
tons, les cases a cocher, les noms de champs de saisie, etc. Les menus,
les commandes, les champs de fenétres et les boites de dialogue utili-
sés dans le logiciel ainsi que les onglets et les groupes du ruban sont éga-
lement marqués.

[y Ce symbole signifie que des informations supplémentaires sont dis-
ponibles dans l'aide en ligne.

Utilisez pﬁ%‘}ce (dans la barre de menus de cette aide), pour agrandir
ou réduire la taille des caractéres de la présente aide. Tout clic sur
ce symbole fait passer a la taille de police suivante parmi les cing
tailles de polices (fixes) disponibles.

A/
A
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1.2 Utilisation

Si catman ne vous est pas encore familier, nous vous recommandons de
lire la section L'essentiel en bref a I'issue de l'installation.

2 Pour tout renseignement supplémentaire, appelez I'aide en ligne

contextuelle de catman. Dans de nombreuses boites de dialogue,
vous trouverez, a proximité des champs de saisie, un lien vers la
rubrique correspondante de l'aide : @

En cas de problémes impossibles a résoudre, vous trouverez, dans la sec-
tion Support technique, plusieurs possibilités d’obtenir directement de l'aide
aupres de HBM.
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2 Configuration systéme requise

Pour utiliser la version actuelle de catman, vous devez disposer d’'un PC

ayant la configuration requise suivante :

* Intel Pentium ou tout autre processeur similaire cadencé a 1 GHz ou
plus

+ Windows® 7 (version 32 bits ou 64 bits, éditions Home, Professional ou
Ultimate), Windows® 8.1 (version 32 bits ou 64 bits) ou Windows® 10
(version actuelle 32 bits ou 64 bits)

& Le systéme de fichiers doit étre NTFS.

*  Microsoft Internet Explorer version 8.0 ou une version plus récente

*  Mémoire de travail (RAM) de 2048 Mo ou plus

« Carte graphique ou écran ayant une résolution d'au moins 1024 x 768
pixels. Nous conseillons d'utiliser une résolution de 1600 x 900 pixels ou
plus. Pour les petits écrans ayant une résolution plus élevée, utilisez si
nécessaire le Panneau de configuration de Windows (parameétres
d'Affichage) pour agrandir I'affichage du texte et autres éléments a
I'écran.

* Env. 1 Go d'espace disque dur disponible pour l'installation de logiciel.
L'enregistrement de données dans des fichiers temporaires nécessite
au moins 1 Go supplémentaire ; toutefois, un autre lecteur (pas un lec-
teur réseau) peut aussi étre utilisé a cet effet.

«  Souris Microsoft ou compatible
* Imprimante standard configurée
* Une des interfaces suivantes pour le raccordement d’appareils de
mesure” :
« USB, Ethernet (10/100 Mbit), FireWire (IEEE 1394b?) ou RS-232
(COM1, COM2).

catman PostProcess ne requiert aucune interface.

Avec FireWire, seules les interfaces selon IEEE 1394b sont prises en
charge. Les pilotes d'interface HBM (adaptateur pour IP over FireWire
inclus) doivent étre installés (compris dans le logiciel d'installation de cat-
man).

®
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* Les polices suivantes doivent avoir été installées :

* Arial (TT), Courier, MS Sans Serif, Petites polices, Tahoma, Times
New Roman (TT), Verdana, Segoe Ul et Wingdings. Ces polices de
caractéres sont normalement installées en méme temps que le sys-
téme d'exploitation Windows.

Remarques

*  Pour pouvoir enregistrer des données de mesure, vous devez disposer
d’un espace de stockage suffisant sur votre disque dur. Servez-vous
comme point de repaire de 8 octets par valeur de mesure pour un calcul
approximatif. Cela signifie que pour 100.000 valeurs, vous aurez
besoin, pour 50 voies, d’environ 40 Mo. Le menu Fichier -> Options et
Enreqistrement des données (groupe Systéme) permet de modifier le
lecteur sur lequel le systéeme doit enregistrer le fichier temporaire de
mesure.

* En présence d'un grand nombre de voies, nous recommandons d'utili-
ser une taille de mémoire fixe pour la mémoire de mesure temporaire.
Ceci permet a I'enregistrement du fichier de données (temporaire) d’étre
plus rapide.

Voir aussi Enregistrement des données (groupe Systéme)

« Enl'absence d'un espace de stockage disponible suffisant, le systéeme
interrompt la mesure. Cependant, a c6té de @ dans la barre d’état, le
systéme indique combien de temps vous pouvez encore réaliser des
mesures, avant que cela ne se produise (d = jours, h = heures). Lors du
calcul, le systéme tient compte de 100 Mo de réserve de sécurité. L'état
est affiché sur fond rouge, des que I'espace disponible passe en des-
sous d'1 Go.

» La exigences susmentionnées sont suffisantes, lors de la mesure d'un
nombre restreint de voies a faible vitesse de mesure et lors de I'utilisa-
tion de sorties graphiques limitées. Pour éviter d'avoir des problémes
lorsque le nombre de voies de mesure ou de calcul est élevé ou lors de
sorties graphiques complexes et de vitesses de mesure plus ou moins
élevées, il convient d'utiliser un matériel PC plus ou moins puissant en
conséquence.
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2.1 Options d'enregistrement de données

Mémoire de données de mesure temporaire

i) Voir aussi Configuration systeme requise, Répertoire de travail cat-
man

Pour pouvoir stocker les données de mesure générées jusqu'a ce que vous
ayez décidé de leur utilisation ultérieure (en fin d’'opération de mesure), cat-
man utilise une mémoire temporaire de mesure. Par défaut, un fichier spé-
cial est créé dans le répertoire de travail catman. Si le chemin d'acces a ce
répertoire utilisateur est un chemin réseau, au démarrage de catman, un
message indiquant que cela n'est pas autorisé apparait. Dans la boite de
dialogue qui apparait, indiquez un chemin local (un dossier disponible sur le
disque dur de votre PC), catman crée alors tous les fichiers utilisateur
requis au niveau de ce chemin d'acceés.

©- En présence de plusieurs utilisateurs PC ayant des comptes Win-
dows différents (noms d'utilisateurs), nous recommandons d'utiliser
un fichier pour tous les utilisateurs, afin de ne pas réserver inutile-
ment beaucoup de place pour ces fichiers. Assurez-vous toutefois
que le répertoire sélectionné ne soit pas en lecture seule pour tous
les utilisateurs. Indiquez ce répertoire au niveau de tous les utilisa-
teurs de catman.

- ~

Lorsque I'ordinateur tourne sous un systeme d’exploitation a systéme de
fichiers NTFS, la taille de ce fichier peut augmenter de maniere dynamique
jusqu’a saturation du disque dur. Toutes les données peuvent donc étre
acquises, puis exportées dans un fichier « normal » a l'issue de la mesure.
Le message d'état qui apparait au démarrage de catman « Configuration de
mémoire de mesure temporaire en cours » signifie que ce fichier spécial est
en cours d'initialisation.

Si le systeme de fichiers de votre disque dur n'est pas NTFS, vous
devez utiliser une taille mémoire fixe et définir la taille de la
mémoire de mesure temporaire. Le nombre maximal de valeurs de
mesure que vous pouvez acqueérir par voie avec votre configuration
(nombre de voies et taille de mémoire) est ensuite affiché.

o
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Servez-vous comme point de repaire de 8 octets par valeur de mesure pour
un calcul approximatif de la taille du fichier temporaire. Cela signifie que
pour 1.000.000 valeurs (prés de 7 minutes a une vitesse de mesure de

2 400 Hz) environ 400 Mo sont nécessaires pour 50 voies.

En I'absence d’un espace de stockage disponible suffisant, le sys-

-

teme interrompt la mesure. Cependant, a coté de @ dans la barre
d’état, le systéme indique combien de temps vous pouvez encore
réaliser des mesures, avant que cela ne se produise (d = jours,

h = heures). Lors du calcul, le systéme tient compte de 100 Mo de
réserve de sécurité. L’état est affiché sur fond rouge, des que
I'espace disponible passe en dessous d'1Go.

Comment reconnaitre le systéme de fichiers de votre disque dur ?
Dans le répertoire racine du disque dur, (par ex. c:\), appelez le menu
contextuel Propriétés. Le systeme de fichiers utilisé est indiqué sur la troi-
siéme ligne de la boite de dialogue qui apparait ensuite.

& Si le disque dur de votre PC n'a pas été livré formaté avec NTFS,
nous vous recommandons d'accomplir cette opération ultérieure-
ment. En général, le fournisseur du PC propose un logiciel de
conversion a cet effet. Si ce n’est pas le cas, essayez d’exécuter le
fichier CONVERT.EXE (disponible dans le dossier SYSTEM32 de
Windows) avec les paramétres c: /fs:ntfs sic'estle lecteur a
convertir (CONVERT.EXE c: /fs:ntfs).

La conversion est exécutée sans perte de données. Cependant,
pour des raisons de sécurité, vous devriez auparavant faire une
sauvegarde de votre disque dur.

2.2 répertoire de travail catman

i Le répertoire de travail catman ne doit pas étre créé sur un lecteur
= réseau.

Al'issue de l'installation de catman, tous les autres fichiers et répertoires
requis par catman, par exemple pour la base de données capteurs, I'enre-
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gistrement de données ou de projets et la mémoire de données de mesure
temporaire, sont créés dans le répertoire de travail catman. Les options cor-
respondantes vous permettent de modifier certains de ces répertoires ou
chemins d'accés. Toutefois, le répertoire de travail catman est requis égale-
ment, par exemple, pour I'enregistrement temporaire de données dans le
cadre de calculs et contient les exemples d'Autoséquence. Par défaut, le
répertoire de travail catman est créé dans le répertoire « Mes
documents\HBM » de I'utilisateur ayant ouvert une session Windows. S'il
s'agit d'un chemin réseau, le systéme affiche, des le démarrage de catman,
un message indiquant que cela n'est pas autorisé. Cette option vous permet
de sélectionner de maniere ciblée un répertoire d'enregistrement des don-
nées requises par catman.

0" Indiquez un répertoire pour lequel tous les utilisateurs disposent de
droits, si plusieurs utilisateurs ouvrant une session Windows sous
des noms différents, doivent utiliser les mémes parametres. Sinon, il
vous suffit de définir la méme base de données capteurs pour tous
les utilisateurs (voir Aide en ligne, Options capteurs dans les options
de programme) et, le cas échéant, le méme chemin pour la
mémoire de données de mesure temporaire.

- ~
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3 Installation/mise a niveau

(i) Voir aussi Inscription et enregistrement de licence

& Des droits d’administrateur sont requis pour pouvoir procéder a l'ins-
tallation. Nous recommandons de quitter tous les programmes en
cours d'exécution. Aprés l'installation, il peut s'avérer nécessaire de
redémarrer Windows.

Introduisez le DVD dans le lecteur. Dans sa configuration standard, Win-
dows ouvre automatiquement le DVD et affiche la fenétre de démarrage.

Si vous avez désactivé la fonction de démarrage automatique de Windows
ou obtenu les fichiers d'installation par téléchargement, recherchez le fichier
« Start » ou « Start.exe » (répertoire principal du DVD ou du télécharge-
ment), puis double-cliquez sur le symbole correspondant pour que la
fenétre de démarrage apparaisse.

Sélectionnez la langue d'installation sous Langue en haut a droite de la

fenétre de démarrage.

Cliquez sur Installer catman et suivez les instructions du programme d'ins-

tallation. Lisez le contrat de licence attentivement et entrez le répertoire

d'installation du logiciel : confirmez le répertoire cible proposé ou cliquez
sur Parcourir et sélectionnez le répertoire souhaité. Le programme d'instal-
lation crée, le cas échéant, le répertoire que vous avez défini et y copie
ensuite tous les fichiers. L'étape suivante vous permet de sélectionner les
composants a installer en option :

* Installer pilote USB HBM : ce pilote n'est nécessaire que si vous vou-
lez utiliser I'appareil HBM MGCplus avec CP22/42 via une interface
USB de votre PC. Le systéme copie d'abord uniquement les fichiers
requis. Ce n'est que lors du raccordement d'un appareil que le pilote est
(automatiquement) installé complétement par le systeme d'exploitation.
Voir aussi Remarques concernant l'interface USB

* Pilotes FireWire : Ce pilote est nécessaire uniguement si vous voulez
utiliser des modules QuantumX/SomatXR via une interface FireWire de
votre PC. Pour le raccordement d'un module CX27 ou MX a fonctionna-
lité¢ C (par ex. MX471C) au PC via Ethernet et a d'autres modules Quan-
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tumX/SomatXR via FireWire, ce pilote n'est pas nécessaire.

Voir aussi Remarques concernant l'interface FireWire (IEEE 1394)
Pilote CANHEADdirect : ce pilote n'est nécessaire que si vous voulez
utiliser des modules CANHEAD® via I'adaptateur USB-CAN (Peak).
Voir aussi Remarques sur l'interface bus CAN (CANHEADdirect)

Serveur horaire NTP : Cette installation est utile seulement pour Quan-
tumX/SomatXR, MGCplus, PMX, DMP41 et les BraggMETER FS22,
étant donné que ceux-ci peuvent obtenir du serveur horaire des infor-
mations horaires exactes. Le systéme installe le serveur horaire de
Meinberg. Une synchronisation du serveur horaire avec un serveur
horaire dans Internet n'est pas requise et n'est pas non plus configurée
par l'installation automatique. Le serveur horaire sert uniquement a la
synchronisation des appareils impliqués dans la mesure.

Vous pouvez également installer le serveur horaire NTP ultérieurement
ou sur un autre PC, voir aussi http://www.meinberg.de et

« Synchronisation de plusieurs appareils » dans l'aide en ligne.
Installer I'ancien éditeur de TEDS : Cette installation n'est normale-
ment pas nécessaire car la base de données capteurs vous permet
d'inscrire de nouveaux modules TEDS (vides), mais aussi de modifier
aisément des modules existants, voir « Utiliser des capteurs a TEDS »
dans l'aide en ligne. Cet éditeur est uniquement requis si vous souhai-
tez visualiser ou éditer des contenus TEDS tels qu'ils sont spécifiés
dans la norme TEDS.

Avant de copier les fichiers, le programme d'installation affiche encore un
apercu des actions a accomplir qu'il vous faut confirmer par un clic sur Ins-
taller.

Remarques

catman

Nous conseillons de démarrer catman une fois avec les droits d'admi-
nistrateur juste aprés l'installation. Entrez le numéro de licence et rac-
cordez les appareils a utiliser, pour que les pilotes puissent étre installés
complétement (nécessite des droits d'administrateur).

L'installation ultérieure d'un pilote risque de durer plusieurs minutes,
étant donné que Windows essaie d'abord de détecter le pilote sur Inter-
net. Nous recommandons donc de réaliser l'installation du pilote par le
biais du programme correspondant (voir les sections « Remarques... »
correspondant a l'interface concernée).
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http://www.meinberg.de/

I
[
<

3.1 Remarques concernant I'interface Ethernet

Pare-feu de Windows

Si vous établissez une connexion a un appareil HBM via Ethernet, cette
connexion est bloquée, la plupart du temps, par le pare-feu de Windows ou
par le pare-feu de votre antivirus. Lors de l'installation de catman, une
exception est définie pour le pare-feu de Windows. Pour les autres pro-
grammes, autorisez I'accés pour catmanEasy ou catmanEasy-AP.

Autres pare-feu

Selon les appareils raccordés, autorisez les ports suivants :

*  QuantumX/SomatXR: ports TCP 80, 5001 et 7411, UDP pour les ports
1200, 1201, multi-diffusion UDP pour les ports 1300, 1301 et 31 416 et
31417, pour le CX27 les ports TCP a partir de 50 000,

*  MGCplus avec CP22/42 : port TCP 7 (pas d’'UDP ou de multi-diffusion),
MGCplus avec CP52 : ports TCP 7 et 80, multi-diffusion UDP pour les
ports 31416 et 31417,

*  DMP41 : port TCP 1234, multi-diffusion UDP pour les ports 31416 et
31417,

*  PMX: port TCP 55.000, multi-diffusion UDP pour les ports 31 416 et 31
417,

*  BraggMETER FS22 : Ports TCP 3500 et 3365,
» System 2000 de Kistler : UDP pour les ports 8888 et 8889,
» Kistler KiRoad : ports TCP 6155 et 6158, UDP pour le port 6156.

Connexion a MGCplus via WLAN

Si vous établissez la connexion au MGCplus via un WLAN et pas par cable,
une interruption de la connexion (dépassement de délai d'attente) risque de
se produire avec les réseaux lents. Dans un tel cas, mettez le délai d'attente
d'interrogation du tampon de sortie sur une valeur plus élevée.

L'apport de modifications au registre a I'aide du programme rege-
dit.exe doit étre réservé a des utilisateurs expérimentés et étre exé-
cuté a l'issue d'une sauvegarde du registre actuel, car dans cer-
taines conditions, les modifications risquent d'entrainer des erreurs

s
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graves dans Windows. Faites réaliser les modifications par votre
administrateur systéme.

Créez sous HKEY_LOCAL_MACHINE/SOFTWARE/HBM/CATMAN/SET-
TINGS, la nouvelle chaine de caractéres MGCGetFifoTimeout et indiquez
une valeur de plus de 500 (ms), telle que 1500.

3.2 Remarques concernant I'interface USB

Vous pouvez également installer le pilote USB lors de l'installation de cat-
man (par défaut : le pilote USB est installé). Si cela n'est pas le cas, vous
pouvez également installer le pilote ultérieurement, voir la description ci-
dessous.

Information sur la version du pilote

Le pilote fourni avec catman pour MGCplus a été perfectionné en 2010 et la
version actuellement disponible est la version 3.3.3.2 du 25/03/2010 : il est
signé (requis pour les versions 64 bits de Windows) et n'a plus besoin de
programme d'installation, si un appareil est raccordé a un autre port USB de
votre PC. Si une boite de dialogue Windows signalant la détection de nou-
veau matériel apparait lors du raccordement d'un appareil, alors faites Ins-
taller le logiciel automatiquement, étant donné que Windows détecte
automatiquement le pilote. Ce n'est que lors du raccordement d'un (nouvel)
hub USB que suivant votre systéme, une installation compléte risque de
devoir étre réalisée. Dans un tel cas, procédez comme décrit ci-dessous
pour l'installation.

Mise a jour de pilote, controle de la version de pilote

Si une installation plus ancienne de catman était déja disponible sur votre
PC, tout ancien pilote éventuel est alors conservé lors d'une réinstallation.
Pour installer un nouveau pilote, vous devez d'abord désinstaller I'ancien
pilote. Normalement, cela est effectué par le programme d'installation. Si ce
n'est pas le cas, par exemple parce que l'installation a été interrompue,
vous devez alors le faire manuellement (droits d'administrateur requis).
Avec les pilotes récents, vous pouvez également voir la version actuelle-
ment installée via Panneau de configuration -> Programmes et fonction-
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nali

tés ou, sous Windows 10, via Paramétres -> Systéme -> Applications

et fonctionnalités. Utilisez sinon la procédure décrite ci-dessous jusqu'a
I'étape 4.

Pro
1.
2.
3.

6.
7.

cédure de désinstallation d'un ancien pilote
Raccordez un MGCplus via USB.
Faites apparaitre le Panneau de configuration de Windows.

Faites un double clic sur « Gestionnaire de périphériques ». (Commutez
I'affichage si nécessaire.)

Le systéme affiche les anciens pilotes sous forme de sous-entrée de
« Controleur USB » et les nouveaux pilotes sous forme d'entrée sépa-
rée. Faites un clic droit sur I'entrée et sélectionnez Propriétés.

Cette boite de dialogue affiche la version actuellement installée.

Dans I'onglet Pilotes, cliquez sur Pour désinstaller le pilote et atten-
dez que la désinstallation soit terminée.

Débranchez le connecteur USB du MGCplus.
Attendez environ 10 secondes avant d'installer le nouveau pilote.

Procédure d'installation (ultérieure) d'un pilote USB

1.

14

Naviguez jusqu'au répertoire « DriverSetups » dans le répertoire d'ins-
tallation de catman.

Faites un double clic sur « HBM USB IODriver Setup.exe ».

Lisez attentivement le contrat de licence et suivez les instructions du
programme d'installation.

Le programme d'installation copie les fichiers requis dans le dossier
Windows correspondant et configure le pilote.

Branchez le connecteur USB au MGCplus.

Si le systéme vous invite a établir une connexion a Windows Update,
activez Non, pas maintenant et cliquez sur Continuer.

Activez Installer le logiciel automatiquement.

Windows met alors les fichiers requis a jour. Attendez jusqu'a ce que le
message « Nouveau matériel détecté » dans la barre des taches de
Windows apparaisse. N'exécutez catman qu'ensuite.
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Deés qu'un appareil est raccordé, le nouveau pilote apparait en tant
qu'entrée séparée sous « HBM USB Devices » au niveau du Gestionnaire
de périphériques. Les pilotes sont par ailleurs affichés dans la liste des pro-
grammes installés (Panneau de configuration -> Programmes et fonc-
tionnalités ou, sous Windows 10, Paramétres -> Systéme -> Applica-
tions et fonctionnalités).

3.3 Remarques concernant I'interface FireWire (IEEE
1394)

Les pilotes FireWire requis peuvent étre également installés (composants
facultatifs) lors de l'installation de catman. Si cela n'est pas le cas, vous
pouvez également installer les pilotes ultérieurement, voir la description ci-
dessous.

& Des droits d’administrateur sont requis sous Windows pour pouvoir
procéder a l'installation. Si vous utilisez une carte enfichable pour
I'interface FireWire, vous devez enficher la carte dans le PC avant
I'installation, pour que le pilote HBM soit activé automatiquement
pour la carte.

Pour l'interface FireWire (IEEE 1394b) des modules QuantumX/SomatXR,
vous devez utiliser le pilote fourni par HBM. Cependant, vous pouvez pas-
ser a tout moment au pilote d'origine de votre interface.

A l'issue de l'installation, démarrez catman normalement et, dans la boite
de dialogue Préparer un nouveau projet, indiquez FireWire comme inter-
face.

IP over FireWire (adaptateur IP IEEE1394 de HBM)

A partir de la version 3.4, la communication avec les modules Quan-
tumX/SomatXR via FireWire est comparable a celle via Ethernet. Pour cela,
une interface virtuelle est configurée pour chaque port FireWire présent
physiquement : IP over FireWire. Deux adaptateurs maximum sont créés et
visibles dans les connexions réseau. Les adresses IP utilisées sont 24.0.0.1
et 25.0.0.1. Les adaptateurs d'interface s'appellent donc IP over FireWire
24 et IP over FireWire 25. (Le second n'est présent que si le PC comporte
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plus d'un port physique1). L'interface IP over FireWire nécessite unique-
ment le protocole Internet TCP/IP (IPv4). Le client pour les réseaux Micro-
soft ou le planificateur de paquets QoS n'est pas nécessaire.

Procédure d'installation (ultérieure) des pilotes

1. Naviguez jusqu'au répertoire « DriverSetups » dans le répertoire d'ins-
tallation de catman.

Faites un double clic sur « HBM IEEE1394 Driver Setup.exe ».

3. Lisez attentivement le contrat de licence et suivez les instructions du
programme d'installation.

Le programme d'installation copie les fichiers requis dans le dossier
Windows correspondant et configure les pilotes ainsi que |'adaptateur IP
over-FireWire.

~@: En cas de problémes de connexion, vérifiez que I'adaptateur d'inter-
face IP over FireWire 24 a été configuré (Panneau de configuration
Windows -> Centre Réseau et partage -> Modifier les paramétres
de la carte). Si ce n'est pas le cas, fermez un appareil et double-cli-
quez sur « HBM IEEE1394 IP Adapter Wizard.exe » dans le réper-
toire DriverSetups.

Activation du pilote HBM en présence de plusieurs interfaces
(i) Le pilote HBM est un pilote Thesycon modifié.

Si votre PC est équipé de plus d'une interface FireWire, vous devez définir

I'interface pour laquelle le pilote doit étre installé.

1. Démarrez le programme « t1394bus_installwizard.exe » (Thesycon
T1394bus Setup Wizard) dans le répertoire « Pilote HBM IEEE1394 ».
Ce répertoire est créé dans le dossier « HBM » du répertoire de fichiers
d'applications de Windows (la plupart du temps « C:\Program
Files\HBM\Pilotes HBM IEEE1394 »).

1) Une carte FireWire peut, par exemple, étre équipée de 3 ports, toutefois elle
n'est souvent enregistrée aupres du systeme qu'en tant qu'interface unique.
Dans ce cas, seul un adaptateur IP over FireWire est configuré (adaptateur
IP IEEE1394 de HBM).
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2. Sélectionnez le contréleur hote IEEE 1394 souhaité en cliquant dans la
liste. Le « Thesycon T1394bus Setup Wizard » affiche tous les
1394_OHCI_HostController disponibles sur le PC. Si vous disposez de
plusieurs adaptateurs, vous pouvez en sélectionner un. Dans le cas
contraire, cliquez sur la premiére entrée.

3. Cliquez sur Switch to T1394bus driver, pour installer le pilote HBM.

4. Fermez le programme « Thesycon T1394bus Setup Wizard ». Le pilote
est alors installé et prét a étre utilisé.

Si vous voulez réactiver le pilote d'origine de votre interface FireWire, exé-
cutez a nouveau le Thesycon T1394bus Setup Wizard, sélectionnez le
contréleur héte IEEE 1394 (IEEE 1394 Host Controller) correspondant et
cliqguez sur Switch to in-box T1394 driver. Le pilote HBM est alors désac-
tivé, sans étre désinstallé. Toutefois, vous pouvez, a tout moment, passer
d'un pilote a l'autre.

Remove T1394bus driver from system supprime entierement le pilote
HBM de votre PC.

Installation du pilote spécifique a I'appareil
1. Raccordez le module MX.

Peu de temps aprés, une boite de dialogue Windows qui apparait
signale qu'un nouveau périphérique a été détecté et invite a rechercher
un pilote dans I'Internet.

2. Activez Non, pas maintenant et cliquez sur Continuer.
3. Activez Installer le logiciel automatiquement.

Windows met alors les fichiers requis a jour. Attendez jusqu'a ce que le
message « Nouveau matériel détecté » dans la barre des taches de
Windows apparaisse. N'exécutez catman qu'ensuite.
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3.4 Remarques concernant l'interface bus CAN avec
CANHEADdirect

Les pilotes CANHEADdirect requis peuvent étre également installés lors de
I'installation de catman (composants facultatifs). Si cela n'est pas le cas,
vous pouvez également installer les pilotes ultérieurement, voir la descrip-
tion ci-dessous.

Pour obtenir I'interface bus CAN du PC en vue d'un raccordement direct de
modules CANHEAD®, vous devez installer I'adaptateur USB-CAN de Peak
et le cas échéant configurer un réseau CAN. A l'issue de l'installation,
démarrez catman normalement et indiquez CANHEADdirect comme inter-
face dans la boite de dialogue Préparer un nouveau projet.

Procédure d'installation (ultérieure) du pilote

1. Naviguez jusqu'au répertoire « DriverSetups » dans le répertoire d'ins-
tallation de catman.

2. Faites un double clic sur « HBM Peak Driver Setup.exe ».

3. Lisez attentivement le contrat de licence et suivez les instructions du
programme d'installation.

Le programme d'installation copie les fichiers requis dans le dossier
Windows correspondant et configure le pilote.

Configurer I'adaptateur USB-CAN
1. Branchez I'adaptateur USB-CAN sur un port USB libre du PC.

2. Mettez I'adaptateur sous tension (les deux DEL cété raccordement
doivent étre vertes).

Peu de temps aprés, une boite de dialogue Windows qui apparait
signale qu'un nouveau périphérique a été détecté et invite a rechercher
un pilote dans I'Internet.

3. Activez Non, pas maintenant et cliquez sur Continuer.

4. Dans la fenétre suivante, faites Installer a partir d'une liste ou d'un
emplacement spécifié.
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5. Indiquez le chemin d'accés au fichier PCAN_USB.SYS (dossier CAN-
HEADdirect du répertoire d'installation de catman). Windows copie les
fichiers requis dans les dossiers Windows correspondants.

Configurer un réseau CAN

Le logiciel de PEAK permet de définir plusieurs réseaux CAN utilisant par
exemple des débits binaires différents pour diverses applications, méme en
présence d'un adaptateur unique. Suivant le réseau que vous sélectionnez
ultérieurement, le systeme utilise alors le débit binaire correspondant, sans
que vous ayez besoin, a chaque fois, de modifier vous-méme le débit
binaire au niveau de I'adaptateur. En complément, le logiciel PEAK englobe
des programmes d'affichage d'état et d'essai d'appareils bus CAN par le
biais de messages CAN.

Lors de l'installation de catman, un réseau est déja configuré pour les
modules CANHEAD®, si I'adaptateur était raccordé au moment de l'installa-
tion. Dans le cas contraire, raccordez |'adaptateur et exécutez le pro-
gramme NetCreator.bat disponible dans le dossier CANHEADdirect (dans
le répertoire d'installation de catman), afin de faire configurer automatique-
ment le réseau CANHEAD_DIRECT. Le débit binaire a utiliser de 250 kbit/s
est également activé lors de I'opération.

®
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4 Désinstallation

Pour désinstaller catman, ouvrez la liste des applications Windows instal-
Iées. Dans cette liste, sélectionnez l'installation de catman.

Afficher la liste des applications sous Windows 10

Entrez Modifier ou supprimer un programme dans le champ de
recherche de la barre des taches et exécutez le programme proposé par
Panneau de configuration.

Vous pouvez aussi utiliser Paramétres -> Systéme -> Applications et
fonctionnalités dans le menu Démarrer ou Tous les paramétres -> Sys-
teme -> Applications et fonctionnalités dans le Centre de notifications.

Afficher la liste des applications sous Windows 8/8.1

Dans la barre des charmes apparaissant sur le bureau de Windows (et
non pas celle au niveau de I'affichage de la mosaique), sélectionnez Para-
métres -> Panneau de configuration. Double-cliquez sur Programmes et
fonctionnalités (Affichage : Petites icones) ou Désinstaller un pro-
gramme (Affichage : Catégorie).

Afficher la liste des applications sous Windows 7

Par le biais du menu Démarrer de Windows, appelez le Panneau de confi-
guration -> Centre Réseau et partage. Double-cliquez sur Programmes
et fonctions (Affichage Petites icones) ou Désinstaller un programme
(Affichage : Catégorie).

Remarques

* Le systéme ne supprime que les fichiers créés lors de l'installation et
pas ceux créés lors de I'utilisation de catman.

* Les utilitaires installés conjointement a catman, tels que le serveur
horaire NTP, ne sont pas désinstallés automatiquement. Si ces applica-
tions sont devenues superflues, désinstallez-les par le biais du Panneau
de configuration de Windows.
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Les programmes ou pilotes ayant été installés pour des interfaces spé-
ciales, telles que USB, bus CAN ou FireWire, ne sont pas non plus
désinstallés automatiquement. Utilisez également a cet effet le Pan-
neau de configuration de Windows.
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5 Inscription et enregistrement de licence

& Voir aussi https://www.hbm.com/terms/software a propos des condi-
tions de licence du logiciel (EULA)

Au premier démarrage du logiciel, vous devez entrer votre nom et celui de

votre société, ainsi que le numéro de licence indiqué sur le DVD. Si vous

n'indiquez pas de numéro de licence, catman démarre en mode d’évalua-

tion (25 démarrages maxi. possibles avec I'ensemble des fonctions).

Dans la fenétre de démarrage de catman, cliquez sur Info, si vous :

» voulez entrer votre numéro de licence dans une phase ultérieure,

« voulez modifier votre nom ou celui de votre sociéte,

* voulez générer un fichier d'information concernant votre systeme PC
(fichier d'information systéme) destiné au support technique de HBM,

* voulez visualiser les modules activés, tels que EasyMath (Mathéma-
tiques et Autoséquence),

» voulez voir les « Release Notes » (en anglais) pour la version actuelle.
Voir aussi la section « Les nouveautés dans catman (historique) » de
I'aide en ligne.

La fenétre qui apparait ensuite affiche les données de licence actuelles du
coté droit. Un clic sur Modifier vous permet de modifier toutes ces informa-
tions.

Remarques concernant I'objet de panneau Carte (uniquement dispo-
nible pour catman AP, catman PostProcess ou le module supplémen-
taire EasyRoadload)

L'objet récupére sur Internet une carte mise a disposition par Google Ire-
land Ltd. Lors de la demande, aucune information sur l'utilisateur ou le PC,
en dehors de l'adresse IP, n'est transmise a Google.

L'utilisation des cartes n'est autorisée qu'avec catman. Cet objet n'est pas
disponible dans tous les pays en raison de restrictions de licence, par
exemple en Chine ou Corée du Nord. Vous pouvez toutefois choisir d'utili-
ser Baidu Maps si vous possédez un compte Baidu. Pour de plus amples
informations, veuillez consulter « Working with Baidu Maps in China » dans
la Knowledge Base ainsi que
http://Ibsyun.baidu.com/index.php?title=webapi.
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Inscription et activation de la maintenance logicielle

Veuillez vous inscrire en envoyant un e-mail a systems@hbm.com, afin
d'activer votre contrat de maintenance. HBM a besoin de cette inscription
pour pouvoir garantir que vous puissiez étre avisé de la parution d'une nou-
velle version et recevoir le numéro de licence nécessaire a cet effet. Suite a
votre inscription, vous recevez de HBM un e-mail indiquant les numéros de
téléphone correspondants pour un acces direct au support technique cat-
man de votre région. Les informations suivantes sont requises :

1. le nom du logiciel (catman Easy, catman AP ou catman PostProcess),

2. votre numéro de licence actuel,

3. le nom de la société,

4. votre nom et le cas échéant votre service,

5. votre adresse e-mail.

& La modification de l'inscription, telle qu'un changement de nom

et/ou d'adresse e-mail est possible a tout moment.

Activer un module

1. Cliquez dans la fenétre de démarrage de catman sur Options.

2. Activez le module acheté par le biais de Fonctions de composants
(groupe Systéme).

3. Entrez le numéro de licence, que vous avez obtenu pour le module,
dans la boite de dialogue suivante.

& L’entrée de ce numéro de licence n’est nécessaire qu'a la premiére
activation. Si vous n’avez pas besoin du module temporairement,
vous pouvez le désactiver par le biais du menu Fichier -> Options
et Composants (groupe Systéme) Une coche dans la case corres-
pondante suffit a le réactiver.

Un clic sur Info dans la fenétre de démarrage ou sur Sur catman (menu
Aide) fait apparaitre tous les modules activés accompagnés du numéro de
licence de base.

®
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6 L'essentiel en bref

catman® est le logiciel de technique de mesure des appareils HBM Quan-
tumX, SomatXR, MGCplus, CANHEAD®, PMX, DMP41, eDAQ (SoMat) et
les BraggMETER FS22 SI/DI pour la mesure par jauges optiques. Il vous
permet d'effectuer de maniére simple et rapide vos diverses taches de
mesure, sans avoir a effectuer de programmation. Outre les appareils de
HBM, vous pouvez aussi raccorder un systeme GPS, la station météo Vai-
sala WXT520, un GOM Testing Controller (ARAMIS) pour la mesure
optique d’extension ou des capteurs RoaDyn de Kistler (systeme 2000 ou
KiRoad), dans catman.

catman détecte non seulement la configuration des appareils de mesure
HBM raccordés, mais l'interopérabilité optimale du matériel et du logiciel
permet, par exemple lors de I'utilisation de capteurs a TEDS, une configura-
tion automatique de la chaine de mesure compléte au démarrage. En cas
de voies de mesure avec capteurs courants, vous utilisez la base de don-
nées Capteurs intégrée a catman et assignez simplement les capteurs rac-
cordés aux différentes voies. La base de données capteurs englobant déja
tous les capteurs de HBM en tant que modéles ainsi que des capteurs
typiques, tels que les thermocouples, les Pt100, les sources de tension ou
de courant, permet facilement I'ajout de vos capteurs. Des signaux CAN
peuvent également étre ajoutés a la base de données capteurs puis affec-
tés a des voies de réception CAN. Vous pouvez également inscrire les don-
nées des capteurs de la base de données capteurs sur les modules TEDS
ou reprendre les données d'un module TEDS dans la base de données
capteurs.

Utilisez les paramétres par défaut de catman ou définissez vous propres
séquences de mesure, appelées aussi jobs de mesure : définir la vitesse de
mesure, les triggers de démarrage et/ou d’arrét, y compris la durée de pré-
trigger et I'effet retard. Sélectionner I'heure de démarrage et d’arrét ou lan-
cer et arréter la mesure au clavier. Une combinaison des réglages est éga-
lement possible, par exemple, démarrage par trigger et arrét a expiration
d’'une durée définie ou a I'issue d’un certain nombre de valeurs de mesure,
etc. Créez vos propres visualisations, a I'aide des objets graphiques de
catman : vous disposez de graphiques affichant les courbes pendant la
mesure, d’affichages numériques ou en barres ainsi que de divers objets
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supplémentaires. Cependant, vous pouvez aussi utiliser les préréglages de
catman et démarrer immédiatement une mesure. En cours de mesure éga-
lement, vous pouvez afficher des voies supplémentaires dans les objets
graphiques existants ou dans de nouveaux objets graphiques.

L’achat de modules supplémentaires (payants) permet d’améliorer la ver-
sion standard de catman Easy : La version catman AP comporte catman
Easy et les modules les plus fréquemment utilisés.

La version catman PostProcess est limitée au mode d’évaluation (aucun
raccordement d’appareils ni acquisition de valeurs de mesure possible).

Veuillez vous inscrire auprés de HBM, pour activer votre contrat de

maintenance. HBM a besoin de cette inscription pour pouvoir garan-
tir que vous puissiez étre avisé de la parution d'une nouvelle version
et recevoir le numéro de licence nécessaire a cet effet, voir Inscrip-

tion et enregistrement de licence.

o

6.1 Préparer un nouveau projet de mesure : Scan
d’appareils

& La configuration du scan d’appareils s'obtient dans le menu Mesure
de la fenétre de démarrage de catman via Type d'appareils, inter-
face et autres options relatives au hardware ou via le menu
Options de la fenétre de démarrage de catman et Préparer un
nouveau projet.

Au démarrage d’un nouveau projet de mesure, le systéeme recherche les
appareils du type sélectionné sous Chercher le type d'appareil sur les
interfaces activées dans la configuration du scan d’appareils. Les appareils
doivent étre sous tension et préts a fonctionner, sinon ils ne sont pas détec-
tés. Attendez donc suffisamment longtemps aprés la mise sous tension des
appareils pour démarrer un nouveau projet ou charger un projet existant.

Le raccordement simultané d'appareils HBM différents n'est géré
que dans certaines limites par catman : avec eDAQ/eDAQ-lite,
DMP41, PMX et CANHEADdirect, seuls des appareils du méme
type peuvent étre utilisés. QuantumX/SomatXR ou MGCplus

®
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peuvent étre utilisés aussi conjointement a des FS22 BraggMETER
ou un GOM Testing Controller (ARAMIS). Indépendamment de cela,
vous pouvez intégrer par exemple un récepteur GPS dans le projet
de mesure via Options et I'onglet Appareil supplémentaire ou via
le Gestionnaire de périphériques HBM.

\@/ Lancez une recherche uniquement au niveau des interfaces aux-
quelles un appareil a été raccordé.

6.2 Utiliser le gestionnaire de périphériques HBM

Les modules QuantumX/SomatXR dotés du firmware 4.0 ou d'une version
supérieure, le PMX et le MGCplus avec CP52 signalent leur adresse IP de
maniére périodique dans le réseau. Ces messages sont collectés et analy-
sés. L'adresse IP configurée sur I'appareil est donc sans importance, tous
les appareils joignables dans le réseau (Ethernet) (ou aussi via FireWire
pour les modules MX) sont détectés.

Si vous possédez d'anciens modules MX, vous devez dans un premier
temps actualiser le firmware .

Procédure

* Cliquez sur Nouveau scan de modules, si aucun appareil ou module
n'apparait sur l'onglet Modules trouvés.
Tous les appareils ou modules sont listés sur I'onglet Modules trouvés,
méme les modules ou appareils avec lesquels aucune connexion ne
peut étre établie.

+ En présence de 8, modifiez I'adresse IP.
) apparait devant 'adresse du module si I'appareil ou le module est
réglé et peut fournir des valeurs de mesure. En général, le PC et I'appa-
reil doivent pour cela se trouver dans le méme segment du réseau.

* Siavec QuantumX/SomatXR ou MGCplus avec CP52, la colonne Firm-
ware affiche « Mise a jour nécessaire », vous devez mettre I'appareil ou
le module concerné a jour,
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Si vous avez déja sélectionné et utilisé une fois des appareils ou
modules dans le Gestionnaire de périphériques, activez Se connec-
ter aux derniers appareils utilisés dans la fenétre de démarrage
(menu Mesure) afin de se connecter directement a ces appareils
(sans afficher de nouveau le Gestionnaire de périphériques).

En présence de plusieurs modules MX, ces derniers sont classés selon leur
nom et repris dans l'ordre alphabétique dans la liste des voies. Pour
reprendre les appareils PMX dans l'ordre alphabétique dans la liste des
voies, il suffit de trier la liste dans le gestionnaire de périphériques HBM :
cliquez sur la colonne Nom avant d'établir la connexion. Les modules
QuantumX/SomatXR raccordés par une passerelle, tels qu’un module
CX27 ou des modules a fonctionnalité C, tels qu’'un MX471C, apparaissent
dans une arborescence en dessous de la passerelle.

Utiliser le MX471C en tant que passerelle

Commencez, le cas échéant, un nouveau projet, pour appeler le Gestion-
naire de périphériques HBM. Sur 'onglet Modifier les paramétres de
modules, vous pouvez activer la fonctionnalité de passerelle. Cette fonc-
tion est désactivée par défaut.
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7  Support technique

& Ayez en tous les cas votre numéro de licence a portée de la main.
Vous trouverez ce numéro sur le DVD catman ou dans la fenétre
d'information concernant catman (option Sur catman du menu
Aide).

Si des problemes devaient survenir lors de I'utilisation de catman, I'assis-
tance technique de HBM vous propose :

Assistance par e-mail

info@hbm.com

Assistance téléphonique

L'assistance téléphonique est disponible entre 9h00 et 17h00 (HEC) tous
les jours ouvrés :

+49 6151 803-0

Assistance par fax
+49 6151 803-9100

!

N,
D

Nous recommandons de remplir la boite de dialogue d'inscription
(voir Inscription et enregistrement de licence) et d'envoyer les don-
nées a HBM. HBM vous fait parvenir ensuite des numéros de télé-
phone spéciaux pour une assistance technique directe de catman.
De plus, tant que votre contrat de maintenance ou d’assistance est
valable, vous étes avisé dés qu'une nouvelle version est disponible
et obtenez ainsi également votre nouveau numéro de licence.

Fichier d'information systéme

Pour pouvoir fournir des informations sur votre systéme PC au support
technique de HBM, veuillez générer un fichier d'information systéme dans
la boite de dialogue affichant les informations sur la licence (Info dans la
fenétre de démarrage ou option Sur catman du menu Aide). Avant de
générer le fichier CATMAN_SYSINFO.TXT, vous pouvez sélectionner le

28 A01235_15_Y00_00 HBM: public catman®


mailto:info@hbm.com?subject=Frage zu catman

HBM

chemin du fichier, ce chemin étant affiché a nouveau en complément a
l'issue de la génération.

Vous disposez également des possibilités ci-dessous

Assistance HBM et distribution dans le monde
https://www.hbm.com/contact/worldwide/

Télécharger des mises a jour logicielles de HBM

https://www.hbm.com/logiciel

Veuillez noter que les nouvelles versions (par ex. 5.0, 5.1, etc.) du logiciel
nécessitent également un nouveau numéro de licence. Inscrivez-vous donc
(voir Inscription et enreqgistrement de licence) et activez ainsi votre contrat
de maintenance. Si vous ne téléchargez qu'un correctif (correction
d'erreurs, par ex. 5.0.1, 5.0.2, etc.), un nouveau numéro de licence n'est
pas nécessaire.

7 Pour de plus amples informations, consultez la rubrique « Support
technique » dans l'aide en ligne.

®
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Hottinger Baldwin Messtechnik GmbH
Tel. +49 6151 803-0

Fax +49 6151 803-9100

info@hbm.com
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